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TUYÊN BỐ BẢN QUYỀN 

Tài liệu này thuộc loại sách giáo trình nên các nguồn thông tin có thể được phép dùng 

nguyên bản hoặc trích dùng cho các mục đích về đào tạo và tham khảo. 

Mọi mục đích khác mang tính lệch lạc hoặc sử dụng với mục đích kinh doanh thiếu lành 

mạnh sẽ bị nghiêm cấm. 

 

  



LỜI GIỚI THIỆU 

 Biên soạn giáo trình không chỉ là một hoạt động nghiên cứu khoa học, mà còn là một 

hành trình sáng tạo. Các giáo viên và giảng viên, dựa trên các phương pháp và nguyên tắc 

chung, đã khéo léo vận dụng vào điều kiện cụ thể để xây dựng nội dung giảng dạy hấp dẫn và 

thu hút người học. 

 Nhằm cung cấp tài liệu cơ sở cho đội ngũ giáo viên để tiến hành các buổi dạy học hiệu 

quả, cũng như hỗ trợ học sinh, sinh viên trong quá trình học tập, Khoa Điện tử đã tổ chức biên 

soạn cuốn giáo trình “Thiết kế mạch điện tử trên máy tính”. Sản phẩm này là kết quả của sự 

đóng góp công sức từ nhóm giáo viên chuyên ngành tại trường Trung cấp nghề Kỹ thuật Công 

nghệ Hùng Vương. 

 Cuốn giáo trình được viết bởi đội ngũ giáo viên giàu kinh nghiệm, với sự hỗ trợ và phản 

biện từ các doanh nghiệp trong lĩnh vực liên quan. Dù đã cố gắng biên soạn một cách kỹ 

lưỡng, chúng tôi hiểu rằng cuốn sách khó tránh khỏi những khiếm khuyết. Vì vậy, chúng tôi 

mong nhận được ý kiến đóng góp từ bạn đọc để cuốn giáo trình này ngày càng hoàn thiện hơn 

trong các lần tái bản sau. 

Xin trân trọng giới thiệu cuốn giáo trình tới bạn đọc! 

 Quận 5, ngày … tháng … năm …… 

  Tham gia biên soạn 

  1. Lê Bảo Khanh 

  2. Lê Huỳnh Quân 

  3. Bùi Quốc Trưởng 
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Bài 1:  GIỚI THIỆU TỔNG QUAN VỀ ORCAD 
I. GIỚI THIỆU: 

Orcad là một chương trình ứng dụng đặc biệt dùng cho việc vẽ mạch nguyên lý, mạch in và mô phỏng 

chính xác mạch điện.  

II. TÌM HIỂU CÁC GIAO DIỆN CỦA CAPTURE CIS: 

Sau khi đã vào được vùng làm việc của Capture CIS, chọn mục File rồi chọn mục New 

hay Open, ta sẽ thấy hiện ra cửa sổ Menu như hình sau: Ơ đây bạn nên chọn: 

Project mở cửa sổ liên thông với các phần mềm khác.  

Design dùng mở trang vẽ dùng vẽ các sơ đồ mạch điện.  

Library dùng mở trang biên soạn thư viện. 

VHDL mở trang lập trình dùng cho việc nạp EPROM. 

Text File dùng mở trang xử lý văn bản. 

Nếu chỉ muốn vẽ sơ đồ mạch điện, ta chọn mục Design, lúc này sẽ thấy trang làm việc 

của Capture Cis. Trong trang vẽ của trình capture cis, bạn thấy có 2 thanh công cụ chính. 

Chúng ta hãy tìm hiểu tác dụng của các tiêu hình có trên các thanh công cụ này. 

1. Ý nghĩa các tiêu hình trên thanh Menu: 

Trên thanh công cụ này chúng ta thấy có các tiêu hình sau : 

 New : dùng tạo ra trang vẽ mới  

Open : mở lại các trang vẽ đã có trên đĩa 

 Save: cho chép lại trang vẽ hiện dùng vào đĩa. 

 Print: cho in các trang vẽ  

 Cut: cắt phần đã chọn trên trang vẽ cất vào Clipboard 

 Copy: chép phần đã chọn trên trang vẽ cất vào Clipboard 

 Paste: dán phần đã có trong trong Clipboard trở vào trang vẽ  
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 Undo: cho lấy lại thao tác (hay trạng thái) trước đó  

 Redo: chọn lại thao tác sau cùng  

 Cache: các linh kiện hiện có lưu trong vùng nhớ tạm  

 Zoom in: phóng lớn trang vẽ.(hình to ra như đưa hình lại gần) 

 Zoom out: thu nhỏ trang vẽ (hình nhỏ lại như đưa hình ra xa) 

 Zoom Area: chỉ cho phóng to trong vùng được chọn  

 Zoom All: cho hiện hết các thành phần có trong trang vẽ 

 Annotate: ghi mã số thứ tự trên các linh liện  

 Back Annotate: tái ghi lại các mã số trên các linh kiện  

 Design Rule Check: mở chức năng kiểm tra lỗi trên trang vẽ 

 Create neslist: cho tạo tập tin trong đó khai báo các đặc tính của mạch.    

 Cross Reference: tạo ra các thông báo về mạch điện 

 Bill of material: tạo ra bảng kê khai các linh kiện trong mạch điện.  

 Snap-to-Grid: tắt, mở tính năng dính hay không dính trên các điểm lưới  

 Project Manager: trở về trang quản lý các tập tin của trang vẽ  

  Help Topics: cho gọi phần trợ giúp  

2. Ý nghĩa của các tiêu hình trên thanh công cụ chính: 

Trên thanh công cụ này chúng ta thấy có các tiêu hình sau:  

 Select: vào mode chọn, nhấp chuột trên các linh kiện để chọn  

 Part: cho mở cửa sổ để chọn linh kiện có trong các thư viện  
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 Wire: vào mode nối mạch, đặt đường nối qua các chân của linh Kiện  

 Net Alias: chọn đặt tên riêng cho các đường nối và các bó nối  

 Bus: đặt tên trang vẽ các bó nối  

 Jumtion: xoá, đặt các dấu nối mạch trên các đường nối giao nhau 

 Bus Entry: đặt các đường dẫn vào ra các bó nối  

 Power: mở cửa sổ để lấy ký hiệu nguồn nuôi hay ký hiệu nối Đất 

Ground: mở cửa sổ để lấy ký hiệu nguồn nuôi hay ký hiệu nối đất 

 Hierarchial Block: đặt khối chữ nhật thay cho một sơ đồ mạch Điện  

Hierarchial Port: đặt các cảng vào hay ra trên các khối chữ nhật. 

 Hierarchial Pin: đặt các chân trên các khối chữ nhật.  

Off-Page Connect: kýhiệu nối mạch bên ngoài trang vẽ.  

 No connect: xác định các chân linh kiện bỏ trống.  

 Line: dùng vẽ hình dạng đường thẳng . 

 Polyline: dùng vẽ các hình khép kín tạo bởi nhiều đoạn thẳng. 

 Rectangle: dùng vẽ hình chữ nhật hay hình vuông.  

 Ellipse: dùng vẽ các hình elip (tròn dẹp) hay hình tròn  

 Arc: dùng vẽ hình các cung tròn  

 Text: dùng nhập văn bản hay thêm phần chú thích vào trang vẽ. 

III. THANH CÔNG CỤ LAYOUT PLUS: 
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Khởi động chương trình orcad bằng cách:  từ màn hình desktop của windows chọn lệnh Start > 

Programs > Orcad Release 9.2 > Layout plus. 

Màn hình tiền layout xuất hiện, sau khi nhấp chọn File > New hay File > Open ta sẽ chuyển màn hình 

Design để bắt đầu thiết kế mạch in dựa vào sơ đồ nguyên lý của mạch. 

Trên màn hình sẽ xuất hiện thanh công cụ sau: 

 

 

1. Lệnh NEW: Tạo bảng mạch in mới theo mẫu hay theo ý muốn. Từ khung màn hình design, chọn lệnh 

File > New. 

2. Lệnh OPEN: 

Khi chọn lệnh này, hộp thoại Open File xuất hiện với danh sách các tập tin mạch in đã được thiết 

kế.  

Tìm tập tin của mình trong khung look in bằng cách nhấp chuột lên mũi tên hướng xuống và chỉ rõ 

đường dẫn thư mục chứa tập tin. Nhấp chọn tên tập tin cần mở. 

Sau khi đã chọn tập tin, nhấp nút Open. Màn hình design xuất hiện bảng mạch in vừa gọi. 

3. Lệnh SAVE, SAVE AS: 

a. Save: Lưu lại tập tin vừa thiết kế và tiếp tục xử lý nếu như đã được lưu trước đó. 

b. Save AS: Lưu bảng mạch in hiện hành theo tên và thư mục mới. Khi chọn lệnh Save As tập tin sẽ 

mặc định là *.MAX.  

4. Lệnh LIBRARY MANAGER: Với lệnh Library Manager, cho phép quan sát, sửa đổi, tạo mới và 

xoá bộ chân cắm. Từ đây cũng có thể tạo thêm thư viện để chứa các bộ chân linh kiện mới theo ý muốn. 

5. Lệnh DELETE: Tương tự lệnh Cut của các chương trình khác trong Windows. Lệnh delete dùng để 

xoá đối tượng tại vị trí cũ và sau đó dùng lệnh Paste để dán lại ở vị trí khác trên cùng bảng mạch hay hay 

là một bảng mạch khác. 

6. Lệnh FIND/ GOTO: 

Tìm vị trí của đối tượng theo tên hay tạo độ. Ngoài ra, có thể dùng lệnh này để đặt đối tượng ở toạ 

độ xác định trong bảng mạch. Từ bảng mạch đang thiết kế, chọn Edit. Hộp thoại Find coordinate or 

reference designator xuất hiện. 

Trong khung Item name: để tìm linh kiện và một trong các chân cắm của nó: nhập vào tên linh kiện 

và số thứ tự chân phân cách nhau bằng dấu chấm và nhấp nút OK. Một ký hiệu vòng trong có dấu chéo 

hiện ngay vị trí đối tượng muốn tìm  
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Dùng lệnh này để hiện màn hình cho phép quan sát những nội dung chi tiết. Để quay lại màn hình 

thiết kế ban đầu, hãy chọn lệnh View > Design. 

7. Lệnh QUERY WINDOW: Dùng lệnh để mở cửa sổ liệt kê các thông tin chi tiết về linh kiện bất kỳ có 

trên bảng mạch thiết kế.  

8. Lệnh ZOOM ALL (FIT): Điều chỉnh bảng mạch thiết kế để có thể quan sát toàn bộ bảng mạch in 

cùng tất cả các chi tiết. 

9. Lệnh ZOOM CENTER: Đưa con trỏ đến vị trí chính giữa màn hình nơi ta nhấp chuột mà không thay 

đổi tỉ lệ của cửa sổ. 

10. Lệnh ZOOM IN: 

Phóng to vị trí được chọn trên bảng mạch in để quan sát chi tiết. Khi chọn lệnh Zoom In, trên đầu 

con trỏ chuột xuất hiện ký tự Z, hãy di chuyển chuột đến vị trí cần phóng to và nhấp chuột.  

Lệnh Zoom In tăng tỷ lệ bảng mạch lên 2:1 mỗi lần thực hiện lệnh. Nhấn nút Esc trên bàn phím để 

thoát khỏi lệnh . 

11. Lệnh ZOOM OUT: 

Thu nhỏ vị trí được chọn trên bảng mạch in để quan sát chi tiết. Khi chọn lệnh Zoom Out, trên 

đầu con trỏ chuột xuất hiện ký tự Z, hãy di chuyển chuột đến vị trí cần thu nhỏ và nhấp chuột.  

Lệnh Zoom Out giảm tỷ lệ bảng mạch lên 2:1 mỗi lần thực hiện lệnh. Nhấn nút Esc trên bàn phím 

để thoát khỏi lệnh. 

12. Lệnh CONECTION: Chứa menu con gồm các lệnh dùng để vẽ các đường mạch in dạng thủ công.  

 Select Tool : Có chức năng đặt bảng mạch thiết kế vào chế độ nối mạch. 

13. Lệnh TEXT: Chứa menu con gồm các lệnh liên quan đến việc xử lý các văn bản nằm trên bản mạch 

in . 

Select Tool : Có chức năng đặt bản mạch thiết kế vào chế độ tạo và sửa đổi các văn bản trên bản mạch 

in . 

13. Lệnh OBSTACLE: Chứa menu con gồm các lệnh dùng xử lý các đường viền nằm trên bảng mạch in. 

Select Tool: Có chức năng đặt bảng mạch thiết kế vào chế độ thêm, di chuyển hoặc xoá toàn bộ các 

đường viền . 

14. Lệnh ERROR: Chứa menu con gồm các lệnh dùng để thể hiện và xử lý các lỗi xuất hiện trong quá 

trình thiết kế bảng mạch in . 

a. Select Tool: Truy tìm lỗi và vị trí của lỗi trong bảng mạch in. 
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b. Select From Spreadsheet: Hiện bảng thông số Error Marker liệt kê tất cả các lỗi được phát hiện 

trong bảng thiết kế. 

Để sửa lỗi, nhấp đúp chuột vào các dòng trong cột Location, vị trí lỗi trên bảng mạch in sẽ xuất hiện. 

So sánh với sơ đồ nguyên lý mạch và sửa lỗi. 

c. Select: Tự động tìm các lỗi khác nếu phát hiện  

d. Delete: Xoá lỗi được chọn. 

15. Lệnh COLOR: Hiện bảng thông số màu sắc được gán cho từng lớp mạch cũng như các đường mạch 

in. Để thay đổi màu sắc, nhấp đúp chuột vào tên đối tượng hoặc lớp mạch in, bảng màu Colors xuất hiện 

cho phép ta chọn màu thay đổi. 

Nhấp OK để đóng bảng màu. Nhấp OK để trở về màn hình thiết kế. 

16. Lệnh REFRESH: Chứa menu con gồm các lệnh liên quan đến việc xoá các đặc tính đã được thực 

hiện trong bảng thiết kế mạch in. 

All: Xoá tất cả các đặc tính xác lập để trở về trạng thái mặc định của chương trình  

17. Lệnh DESIGN RULE CHECK: Hiện hộp thoại Design Rule Check cho phép chọn các thành phần 

quan trọng trong việc thiết kế mạch in. 

18. Lệnh PINS: Chứa menu con gồm các lệnh liên quan đến việc xử lý các chân linh kiện  

Trước khi dùng lệnh pins, phải chọn lệnh options > user preferences, hộp thoại user preferences xuất 

hiện và hãy đánh dấu chọn thành phần allow editing of footprint. 

Select tool: Có chức năng cho phép chọn từng chân một để xử lý 

19. Lệnh COMPONENT: Chứa một menu con gồm các lệnh dùng cho các tác vụ định vị, xử lý và quan 

sát các thuộc tính của các linh kiện trên bản mạch thiết kế. 

Select Tool: Chức năng tương tự khi ta chọn công cụ component trên thanh công cụ để bắt đầu quá 

trình sửa đổi một hay nhiều linh kiện trên bảng mạch thiết kế. 
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Bài 2: THIẾT KẾ MẠCH IN  

I. VẼ MẠCH NGUYÊN LÝ: 

 

 

 

 

 

 

 

 

 

 

 

 

Khởi động chương trình Orcad bằng cách: từ màn hình Desktop của Windows chọn lệnh Start > 

Programs > Orcad Release 9.2 > Capture Cis. 

 

 

 

 

 

 

 

 

 

 

 

 

Cửa sổ màn hình chương trình thiết kế mạch điện nguyên lý xuất hiện với các trình đơn hỗ trợ cho việc 

tạo mới và quản lý các Project (dự án).  
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Từ cửa sổ màn hình này, nhấp chọn biểu tượng Create Document trên thanh công cụ hay chọn File > 

New > Project để tạo một Project mới. 

 

 

 

 

 

 

Hộp thoại New Project xuất hiện. Từ hộp thoại này, ở mục Create a New Project Using nhấp chọn 

Schematic. Trong mục Name nhập tên Project muốn tạo, trong mục Location chọn nút Browse để chọn 

thư mục muốn chứa Project. Chọn xong, nhấp chuột vào nút Ok. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Lập tức màn hình thiết kế xuất hiện với các trình đơn, thanh công cụ định dạng và bảng công cụ vẽ. 

Bên trong màn hình có các lưới ngang dọc để dễ dàng vẽ mạch điện một cách nhanh chóng. 
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 Chú ý: theo mặc định, thanh công cụ nằm đứng ở Góc phải màn hình nhưng ở đây thanh công cụ đã 

được di chuyển đặt nằm ngang bằng cách nhấp và giữ chuột ở đầu thanh công cụ sau đó kéo rê đến vị trí cần 

đặt và nhả chuột . 

Đầu tiên, điều cần làm là lấy linh kiện và đặt chúng lên bản vẽ. Quan sát sơ đồ nguyên lý, ta có thể 

nhận thấy rằng: cần phải lấy và đặt 1 OPAMP LM741, 3 điện trở, 1 tụ điện và các chân cắm (đầu nối) dùng 

để kết nối ngõ vào , ngõ ra và các nguồn DC cung cấp cho Opamp hoạt động. 

 

 

 

 

 

 

 

Nhấp chọn biểu tượng Place Part trên thanh công cụ vẽ hay chọn Place > part  trên thanh Menu (có thể 

chọn tổ hợp phím shift + P trên bàn phím). 
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Hộp thoại Place Part xuất hiện. Hãy tìm các linh kiện cần thiết cho mạch. Lúc này hình dạng linh kiện 

xuất hiện trong cửa sổ bên phải khung Libraries. Nhấp Ok để đóng hộp thoại và trở về màn hình thiết kế. 

Chú ý: nếu trong khung Libraries không có thư viện chứa linh kiện mà ta cần thì hãy nhấp nút Add 

Libraries để thêm thư viện. 

Sau khi chọn được linh kiện OPAMP LM741 trong hộp thoại Place Part và trở về màn hình thiết kế, 

ta thấy hình dạng của linh kiện sẽ xuất hiện trên đầu con trỏ chuột, di chuyển chuột đến vị trí cần đặt trên 

màn hình và nhấp chuột để định vị. Nhấp phím Esc trên bàn phím để kết thúc. 

Tiếp theo là lấy linh kiện điện trở. Nhấp chuột vào biểu tượng Place Part trên thanh công cụ, hộp 

thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện Discrete chứa linh kiện điện trở. 

Trong khung ở trên Libraries , dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn R. Cũng có thể 

nhấp kí tự R vào khung Part để chọn nhanh hơn. Hình dạng linh kiện điện trở xuất hiện ngay trong cửa sổ 

Preview.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Nhấp chọn Ok để trở về màn hình thiết kế. 
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Hình dạng của linh kiện sẽ xuất hiện trên đầu con trỏ chuột, di chuyển chuột đến vị trí cần đặt trên màn 

hình và nhấp chuột để định vị. Vì sơ đồ cần 3 điện trở, nên sau khi định vị trí điện trở thứ nhất, ta hãy di 

chuyển con trỏ đến vị trí khác và tiếp tục nhấp chuột để đặt thêm các điện trở khác. Nhấp phải chuột và chọn 

End Mode từ menu xổ xuống hay nhấp phím Esc trên bàn phím để kết thúc.  

 

 

 

 

 

 

 

 

 

 

 

Kế tiếp là lấy linh kiện tụ điện Capture, nhấp chuột chọn biểu tượng Place Part trên bảng công cụ ve. 

Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện Discrete chứa linh kiện tụ 

điện. Trong khung ở trên Libraries , dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn CAP NP là 

ký hiệu tụ điện  không phân cực. Hình dạng linh kiện tụ điện xuất hiện ngay trong cửa sổ preview bên phải 

khung Libraries .  

Nhấp chọn Ok để trở về màn hình thiết kế. 
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Lúc này hình dạng của linh kiện tụ điện sẽ xuất hiện trên đầu con trỏ chuột, di chuyển chuột đến vị trí 

cần đặt trên màn hình và nhấp chuột để định vị. Nhấp phím 

Esc trên bàn phím để kết thúc việc đặt linh kiện. 

Kế tiếp, hãy lấy các bộ kết nối 2 chân cho các ngõ 

vào, ngõ ra và các nguồn DC cung cấp cho opamp hoạt 

động. Nhấp chọn biểu tượng Place Part trên bảng công cụ. 

 

 

 

 

 

 

Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện Connector chứa bộ kết nối 

2 chân. Trong khung ở trên Libraries , dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn CON2 là 

ký hiệu bộ kết nối 2 chân. Nhấp chọn ok để trở về màn hình thiết kế rồi nhấp chọn vị trí chân cắm.  
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Khi trở về màn hình thiết kế, lúc này hình dạng của bộ kết nối 2 chân sẽ xuất hiện trên đầu con trỏ 

chuột, di chuyển chuột đến vị trí cần đặt trên màn hình và nhấp chuột để định vị tiếp tục động tác di chuyển 

chuột và nhấp chuột để đặt thêm 3 bộ kết nối chân khác trên bảng thiết kế. 

Cuối cùng của công đoạn lấy và đặt các linh kiện là: ta hãy lấy biểu tượng mass để khi tạo mạch in, 

chúng có 1 đường mass nối chung. Nhấp chọn biểu tượng Place ground trên bảng công cụ vẽ. 

 

 

 

Hộp thoại Place Part xuất hiện, chương trình sẽ tự động mặc định chọn tất cả các thư viện có trong 

khung Libraries và từ trong khung bên trên khung Libraries dùng chuột kéo thanh trượt lên xuống để tìm 

và nhấp chọn Gnd_signal/capsym (là biểu tượng Gnd signal trong thư viện capsym) nếu không, cũng có 

thể nhấp chọn thư viện capsym trong khung Libraries và khung symbol bên trên khung Libraries nhấp 

chọn Gnd _signal. Nhấp chọn Ok để đóng hộp thoại Place ground trở về màn hình thiết kế . 
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Lúc biểu tượng mass xuất hiện trên đầu con trỏ chuột, di chuyển chuột đến vị trí cần đặt điểm mass 

trên màn hình và nhấp chuột để định vị. 

Bước tiếp theo việc lấy và đặt 

linh kiện là di chuyển và sắp xếp các 

linh kiện cho thích hợp với sơ đồ 

nguyên lý. Nhấp chọn vào linh kiện 

muốn di chuyển, linh kiện được chọn 

sẽ được đóng khung. Giữ chuột và di 

chuyển đến vị trí thích hợp trên bản 

vẽ rồi nhả chuột để định vị linh kiện 

. Nhấp chuột vào chỗ trống không có 

linh kiện để bỏ chọn linh kiện vừa di chuyển. Lặp lại các bước trên để di chuyển các linh kiện khác đến vị trí 

thích hợp trên bảng thiết kế. 

Trong quá trình di chuyển linh kiện, nếu hướng của linh kiện không nằm đúng thì ta có thể xoay linh 

kiện sang hướng khác phù hợp bằng cách nhấp phải chuột và chọn lệnh Rotate  từ  menu xổ xuống hay 

nhấn phím R trên bàn phím (với điều kiện là ta đã nhấp chọn linh kiện ) mỗi lần ta sử dụng lệnh trên thì linh 

kiện sẽ xoay 1 góc 900. 

Ngoài ra cũng có thể lật 1 linh kiện đối xứng 

theo chiều ngang hay chiều dọc bằng cách nhấp 

chuột để chọn nó, nhấp phải chuột và chọn lệnh 

Mirror Horizontally hay Mirror vertically từ  

Menu xổ xuống. 
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Hình sau đây minh họA cho việc lật đối xứng linh kiện. 

 

 

 

 

 

Sau khi sắp xếp xong, vị trí các linh kiện trên bản vẽ như sau: 

 

 

Kế tiếp tiến hành nối dây giữa các linh kiện. Nhấp chọn biểu tượng Place wire trên bảng công cụ vẽ 

hay chọn place > wire.  

 

Sau khi chọn lệnh, con trỏ chuột sẽ thay đổi thành hình chữ thập(+). Đưa con trỏ đến chân linh kiện 

muốn nối dây và nhấp trái chuột để bắt đầu vẽ. 
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Di chuyển con trỏ chuột đến chân linh kiện thứ 2 và nhắp đúp để kết thúc điểm cuối dây nối, 1 đường 

dây nối sẽ được vẽ. Trong quá trình di chuyển chuột đến chân linh kiện thứ 2 , khi muốn đổi hướng dây nối 

hãy nhắp chuột để tạo góc và di chuyển chuột sang hướng khác.  

Hình sau minh hoạ việc nối dây đã hoàn tất. 

 

Bây giờ ta có thể thay đổi các giá trị đã khai báo cho linh kiện bằng cách nhắp đúp chuột vào văn bản 

dùng để chú thích (giá trị) linh kiện . Ví dụ có thể thay đổi chú thích cho các bộ kết nối J1, J2, J3, J4. Nhấp 

đúp vào dòng chữ CON2. Hộp thoại Display Properties xuất hiện: 

 

Trong khung Value, nhập vào tương ứng với các bộ kết nối là OUT, 12v,-12v, IN. Nhập xong nhấp 

Ok. Lúc đó ta có sơ đồ nguyên lý như sau: 
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Để lưu lại các thiết kế đặt trên, nhấp chuột vào biểu tượng Save Document trên thanh công cụ dưới 

trình đơn. Chương trình Orcad Capture sẽ hỏi: ta có muốn lưu lại tất cả hay không? Nhấp Ok để chấp 

thuận. 

 

 

 

 

 

 

 

Bước tiếp theo ta phải tạo ra tập tin Netlist có phần mở rộng *.MNL để liên kết với chương trình 

layout bằng cách nhắp vào biểu tượng Restore ở góc bên phải của bảng thiết kế. Chú ý: chúng ta đừng lầm 

với biểu tượng tương tự của chương trình capture . 

 

 

 

Kích hoạt cửa sổ quản lý Project và nhấp chọn trang sơ đồ. 

Trước khi tạo Netlist cần phải kiểm tra sơ đồ nguyên lý về các dây 

nối. Nhấp chọn biểu tượng Design Rules Check trên thanh công 

cụ. 
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Hộp thoại Design Rules Check xuất hiện, nhấp chuột vào nút Ok để chương trình bắt đầu tự động 

kiểm tra. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Nếu chương trình không có thông báo gì, tức là sơ đồ nguyên lý không có lỗi. Nếu có lỗi thì chương 

trình sẽ hiện lên 1 bảng thông báo các lỗi và vị trí lỗi để ta có thể dễ dàng trở lại sơ đồ nguyên lý để sửa.  

Sau khi đã kiểm tra lỗi, nhấp chọn biểu tượng Create Netlist để tạo tập tin Netlist. 

 

 

 

 

 

 

 

 

 

 

 

 

Hộp thoại Create Netlist xuất hiện. Trong hộp thoại, chọn nhãn Layout. Trong khung Netlist File, 

theo mặc chương trình sẽ tự động tạo tên tập tin Netlist giống với tên tập tin Project và lưu trong cùng thư 

mục. Nhấp chọn nút ok để tiến hành. 
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Một thông báo của chương trình cho biết tập tin Project sẽ được lưu đến tập tin Netlist. Nhấp OK. 

Sau khi chọn xong, nhấp vào biểu tượng chương trình ở góc trên bên trái màn hình và chọn lệnh Close để 

thoát khỏi chương trình Capture  
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II. TẠO MẠCH IN TỪ SƠ ĐỒ NGUYÊN LÝ BẰNG CHƯƠNG TRÌNH LAYOUT: 

Khởi động chương trình Orcad Layout bằng cách từ màn hình Desktop của Windows chọn Start > 

Programs > Orcad Release 9.2 > Layout Plus. 

 

 

 

 

 

 

 

 

 

Màn hình trắng tiền Layout xuất hiện với các trình đơn hỗ trợ cho việc tạo và quản lý các tập tin mạch 

in. 

Từ trong màn hình tiền Layout nhấp chọn biểu tượng Open New Board hay File > New. 
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Hộp thoại Load Template File xuất hiện. Bên trong hộp thoại này là danh sách các tập tin bản mạch 

với các kích thước mẫu. Chương trình sẽ để ta có thể tự định kích thước, mặc định chương trình là tập tin 

DEAULT.TCH. Nhấp chuột vào Open để tiếp tục 

 

 

 

 

 

 

 

 

 

 

Hộp 

thoại load Netlist Source xuất hiện. Bên trong hộp thoại này hãy chọn tập tin *.MN được tạo ra từ chương 

trình vẽ mạch nguyên lý Capture mà ta muốn thiết kế sơ đồ mạch in. Chọn xong nhấp Open. 

 

 

 

 

 

 

 

 

 

Hộp 

thoại Save File As xuất hiện yêu cầu ta hãy nhập đường dẫn tên (trong mục file name) và thư mục để lưu 

bản mạch sắp được tạo ra. Nhấp nút save để tiếp tục  
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Cửa sổ Automatic ECO Utility xuất hiện, bên trong nó có hộp thoại Link Footprint To Component 

xuất hiện thông báo chương trình không thể tìm thấy chân cắm cho tụ điện  C1 nên ta cần phải chọn chân 

cho C1 có tên linh kiện là CAP_NP. Hãy nhấp chuột vào nút Link existing footprint to component……. 

Để tiến hành chọn. 

 

 

 

 

 

 

 

 

 

 

Hộp 

thoại 

footprint for CAP-Np xuất hiện cho phép ta chọn chân cắm cho linh kiện tụ điện. Trong khung Libraries 

của hộp thoại chọn thư viện chân cắm JUMPER và trong khung Footprints chọn chân cắm mang tên 

JUMPER200. Hình dạng của chân cấm xuất hiện trong cửa sổ ở bên phải. Nhấp ok để chấp nhận . 
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Chú ý: 

tất cả các chân cắm linh kiện đã chọn được chương trình lưu lại và sẽ áp dụng cho các linh kiện tương tự 

trong các bản mạch thiết kế hiện hành và sau này. 

Sau khi nhấp OK, tiện ích ECO sẽ tiếp tục tự động tìm các chân các chân cắm cho các linh kiện khác 

có trong sơ đồ mạch. Nếu không tìm thấy thì chương trình sẽ xuất hiện thông báo là không thể tìm thấy và ta 

cần phải tự tìm. Ví dụ, ở đây chương trình không tìm thấy chân cắm cho linh kiện OPAMP LM741. Hãy 

nhấp nút Link existing footprint to component…  

 

 

 

 

 

 

 

 

 

 

Hộp 

thoại 
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Footprint for LM741 xuất hiện cho phép chọn chân cắm cho linh kiện OpAmp . Trong nhóm hộp 

Libraries của hộp thoại, chọn thư viện chân cắm Dip100b và khung Footprint, chọn chân cấm mang tên 

Dip.100b/8/w.300/L450 là chân cắm có 8 chân. Hình dạng của chân cắm xuất hiện trong cửa sổ Preview ở 

bên phải. Nhấp OK chấp nhận. 

 

 

 

 

 

 

 

 

 

 

Sau khi 

nhấp chọn OK để chọn chân cắm cho linh kiện mà chương trình yêu cầu, các chân cắm cho các linh kiện 

khác thì ta vẫn làm theo các bước trên để chọn chân cắm cho các linh kiện tương ứng. 

 Sau khi cửa sổ Automatic eco Utility thi hành xong thì trên màn hình trên của chương trình xuất hiện 

toàn bộ hình dạng các linh kiện và các dây nối giữa các chân linh kiện . 

 

 

 

 

 

 

 

 

Kế tiếp 

là sắp xếp các linh kiện đặt lên bản mạch sao cho thích hợp. Đầu tiên có thể xoá các chú thích đi theo linh 
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kiện bằng cách chọn biểu tượng Text Tool trên thanh công cụ. Di chuyển trỏ chuột đến các văn bản và nhấp 

chuột để chọn nó sau đó nhấn phím Delete trên bàn phím để xoá nó. 

 

 

 

 

 

 

 

 

 

 

Để sắp 

xếp các loại linh kiện, nhấp chọn biểu tượng Component Tool trên thanh công cụ. 

 

 

Đưa con trỏ chuột đến linh kiện 

cần sắp xếp, nhấp chuột để chọn nó, di 

chuyển chuột đến vị trí muốn đặt và 

nhấp chuột để định vị. Trong quá trình 

di chuyển, ta có thể nhấn phím R trên 

bàn phím để xoay các linh kiện qua 

hướng khác nhằm tối ưu hoá việc đặt 

các linh kiện . 

Tiếp tục hãy vẽ khung viền cho 

bảng mạch nhằm giới hạn kích thước 

của bảng mạch in, nhấp chọn biểu 

tượng Obstacle Tool trên thanh công cụ. 

 

 

Đưa con trỏ chuột đến vị trí góc trên bên trái của khung muốn vẽ, nhấp chuột để bắt đầu vẽ. Di chuyển 

trỏ chuột sang bên phải để vẽ cạnh thứ nhất. Đến góc thứ hai, nhấp chuột để chọn hướng và di chuyển chuột 
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xuống dưới để vẽ cạnh thứ hai. Tiếp tục công việc trên cho đến khi gặp góc kết thúc, nhấp chuột để khép kín 

và nhấp phải chuột chọn lệnh End Command từ Menu xổ xuống. Khung đã được vẽ bao quanh bảng mạch. 

 

 

 

 

 

 

 

 

 

 

 

 

Bước tiếp 

theo là chọn lớp để tạo mạch in. Do mạch này tương đối đơn giản nên có thể định rõ là chỉ tạo 1 lớp. Nhấp 

chọn biểu tượng View Spreadsheet trên thanh công cụ sau đó chọn lệnh Strategy > Route từ  Menu xổ 

xuống.  

 

 

 

 

 

 

 

 

 

 

 

Cử

a sổ 

Route Layer xuất hiện: 
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Trong cột Enabled của cửa sổ này, giữ phím Ctrl và đồng thời nhấp trái chuột để chọn tất cả các lớp 

không muốn tạo trong mạch in, các lớp được chọn sẽ đổi thành màu đen. Sau đó ta nhấp phải chuột và chọn 

lệnh Properties (hay nhấn phím tắt: ctrl + E ) 

 

 

 

 

 

 

 

Hộp 

thoại Edit Layer Strategy xuất hiện. Nhấp chuột vào hộp kiểm tra Routing Enabled bỏ để tuỳ chọn này. 

Sau đó nhấp Ok để đóng hộp thoại Edit Layer Strategy.  

 

 

 

 

 

 

 

 

Lúc này cửa sổ thông số Route layer các lớp của cột Enabled mà ta chọn sẽ đổi từ Yes thành No. 

Nhấp chuột vào biểu tượng Close phía trên góc phải hộp thoại để đóng cửa. 
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Tiến hành định rõ độ rộng của đường mạch in bằng cách nhấp chọn biểu tượng View Spreadsheet và 

chọn lệnh Nest từ Menu xổ xuống.  

Hộp thoại Nets xuất hiện, trong cột Width hãy nhấp chọn toàn bộ cột này 

và nhấp phải chuột. Hãy chọn lệnh Properties từ  Menu xổ xuống. 

 

 

 

 

 

 

 

 

 

 

Hộp thoại Edit Net 

xuất hiện. Trong hộp thoại Edit Net nhập 

các giá trị vào các khung Min Width, 

Conn width, Max width tương ứng là 15, 

17, 20. Nhập xong nhấp OK để đóng hộp 

thoại . 

 

Lúc này các dòng cột của width trong 

cửa sổ Nets xuất hiện các con số mà ta vừa 

nhập. 
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Bây giờ có thể thay đổi màu sắc hiển thị của các lớp mạch in bằng cách nhấp chọn biểu tượng Color 

settings. 

 

 

Cửa sổ Color xuất hiện. Từ cửa sổ này trong cột Color nhấp đúp lớp mà ta muốn đổi màu. Bảng màu 

Color xuất hiện. Nhấp chọn 1 màu, sau đó nhấp OK. 

 

 

 

 

 

 

 

Ta có 

thể cho chương trình tự động chạy mạch in. 

Nhấp chọn Auto > Autoroute > Board. 

 

 

 

 

 

 

 

 

 

 

Một thông báo cho biết việc chạy mạch in đã hoàn thành. Nhấp Ok để tiếp tục. 
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Trên màn hình xuất hiện bảng mạch in đã được thiết kế hoàn tất và ta có thể nhấp chọn biểu tượng 

Zoom In sau đó nhấp chuột vào bảng mạch để phóng to.  

 

 

 

 

 

 

 

 

 

Cuối cùng có thể đặt lên bản mạch các 

chú thích mạch. 

 Nhấp chọn biểu tượng Text Tool trên 

thanh công cụ 

Từ trong khung màn hình chương trình, 

nhấp phải chuột và chọn lệnh New từ Menu 

xổ xuống. 

 

 Hộp thoại Text Edit xuất hiện. Trong 

khung Type Of Text, nhấp chọn tuỳ chọn 

Free, trong mục Text String, nhập vào chú 

thích “MẠCH TÍCH PHÂN OPAMP”và 

trong khung Layer nhấp chọn mũi tên hướng 

xuống để chọn lớp Top. Nhập xong nhấp 

chuột vào nút OK để đóng hộp thoại. Lúc này trên đầu con 

trỏ xuất hiện khung chữ nhật, di chuyển chuột để đưa 

khung chữ nhật đến vị trị cần đặt trong bảng mạch và nhấp 

chuột để định vị. 

 

 

Tương tự hãy tạo ra các chú thích cho ngõ vào, ngõ 

ra, các chân kết nối nguồn cung cấp DC. Nhấp chọn biểu 

tượng Text Tool trên thanh công cụ. 
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Từ khung màn hình chương trình, nhấp phải chuột và chọn lệnh New từ Menu xổ xuống. 

Hộp thoại Text Edit xuất hiện. Trong khung Type of Text, nhấp chọn tuỳ chọn Free, trong mục Text 

String, nhập vào chú thích “In”và trong khung Layer nhấp chọn mũi tên hướng xuống để chọn lớp Top. 

Nhập xong nhấp chuột vào nút Ok để đóng hộp thoại . 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Lúc này trên đầu con trỏ xuất hiện khung chữ nhật, di chuyển chuột để đưa khung chữ nhật đến vị trị 

cần đặt trong bảng mạch và nhấp chuột để định vị. Lặp lại tương tự với các chú thích Out, 12v, -12v. Cuối 

cùng ta có thể phóng to bảng mạch in được thiết kế, ta có thể nhấp chọn biểu tượng Zoom In trên thanh 

công cụ và nhấp chuột vào bảng mạch để phóng to.  
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Muốn xem chỉ 

riêng đường mạch in duy nhất bằng cách chọn Menu View > Clear Screen hay nhấn phím Backspace trên 

bàn phím để xoá toàn bộ màn hình và sau đó nhấn phím số 1 trên bàn phím để xem.  

Để kết thúc, hãy nhấp chọn biểu tượng Save trên thanh công cụ bên dưới trình đơn để lưu lại toàn bộ 

bảng mạch in vừa tạo. 
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Bài 3: VẼ SƠ ĐỒ NGUYÊN LÝ VÀ TẠO MẠCH IN 

CHO MẠCH DÒ TÌM KIM LOẠI 
 

I. Dùng chương trình Orcad Capture để vẽ mạch nguyên lý. 

  

 

 

 

 

 

 

 

 

 

 

Khởi 

động chương trình Orcad bằng cách: Từ màn hình Desktop của Windows chọn lệnh Start > Programs > 

Orcad Release 9.2 > Capture Cis. 

Trên màn hình xuất hiện biểu tượng Orcad  
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Cửa sổ màn hình trắng của chương trình Capture  xuất hiện với các trình đơn hỗ trợ cho việc tạo mới 

và quản lý các Project (dự án).  

 

 

 

 

 

Từ cửa sổ màn hình trắng này, nhấp chọn biểu tượng Create Document trên thanh công cụ hay chọn 

File > New > Project để tạo một Project mới. 

 

Hộp thoại New Project xuất hiện. Từ trong hộp thoại này, ở mục Create a New Project Using nhấp 

chọn Schematic. Trong mục Name nhập tên Project muốn tạo, trong mục Location chọn nút Browse để 

chọn thư mục muốn chứa tập tin Project. 

 Chọn xong, nhấp chuột vào nút Ok. 
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Sau khi nhấp vào Ok lập tức màn hình thiết kế thiết kế của Capture xuất hiện với các trình đơn, thanh 

công cụ định dạng và bảng công cụ vẽ và thanh công cụ thiết kế nằm bên dưới các trình đơn. 

 

Công việc đầu tiên để vẽ sơ đồ nguyên lý là phải lấy các linh kiện đưa lên bảng thiết kế trên màn hình. 

Quan sát sơ đồ ta thấy: 6 tụ điện không phân cực, 1 tụ biến dung, 5 điện trở, 1 transistor npn, 4 cổng nand 2 

ngõ vào, 1 dao động thạch anh 470khz, 1 ngõ vào cung cấp dc, 1 ngõ ra gắn cuộn dò tìm kim loại và 1 

speaker (loa). Nhấp chuột vào biểu tượng Place Part trên thanh công cụ để lấy linh kiện hay place > part 

hoặc nhấn tổ hợp phím shift + p. 

 

 

 

Hộp thoại Place Part xuất hiện, Trong khung Libraries nhấp chọn thư viện Discrete trong khung nằm 

bên trên khung Libraries, dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn Cap NP, cũng có thể 

nhập kí tự C vào khung Part để chọn nhanh hơn. Hình dạng linh kiện tụ điện  xuất hiện ngay trong cửa sổ 

Preview nằm 

bên phải 

Libraries. 

Nhấp Ok để 

đóng hộp thoại. 

Chú ý: 

nếu trong 

khung 

Libraries 

không có thư 

viện chứa linh 

kiện mà ta cần 

thì hãy nhấp 

nút add Libraries để thêm thư viện. Ví dụ trong Libraries không có tên Discrete trong Libraries, ta hãy 

nhấp chọn nút Add Library. 
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Hộp thoại Browse File xuất hiện. Trong hộp danh sách các tập tin thư viện dùng chuột di chuyển 

thanh trượt ngang qua lại để tìm thư viện Discrete. Nhấp chuột chọn nó rồi nhấp Open. Lúc này trong 

khung Libraries của hộp thoại Place Part sẽ xuất hiện thêm thư viện Discrete mà ta vừa chọn. Đối với các 

thư viện khác mà chưa có trong khung Libraries , cũng làm như trên để thêm vào thư viện chứa linh kiện 

cần lấy. 

 

Lúc này hình dạng của linh kiện tụ điện sẽ xuất hiện trên đầu con trỏ chuột, di chuyển chuột đến vị trí 

cần đặt trên màn hình và nhấp chuột để định vị. Nhấp phím Esc trên bàn phím để kết thúc việc đặt linh kiện. 

Sau khi trở về màn hình thiết kế. Lúc này hình dạng của linh kiện tụ điện sẽ xuất hiện trên đầu con trỏ 

chuột, di chuyển chuột đến vị trí cần đặt trên màn hình và nhấp chuột để định vị. Vì cần 6 tụ điện nên lần 

lượt con trỏ chuột đến các vị trí khác đồng thời nhấp chuột để đặt đủ 6 linh kiện tụ điện. Khi đã đạt đủ 6 linh 

kiện lên bảng thiết kế. Nhấp phải chuột và chọn lệnh End Mode tư  Menu xổ xuống để thoát khỏi công cụ 

Place Part (nhấp phím Esc trên bàn phím để kết thúc việc đặt linh kiện). Tiếp theo là lấy tụ điện biến dung. 

Nhấp chọn Place Part trên thanh công cụ. 

Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện Discrete trong khung nằm 

bên trên khung Libraries , dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn Capacitor Var. Hình 

dạng linh kiện tụ điện biến dung xuất hiện ngay trong cửa sổ preview nằm bên phải Libraries . 

Nhấp ok để đóng hộp thoại . 
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 Hình dạng linh kiện tụ điện biến dung xuất hiện trên đầu con trỏ chuột, di chuyển chuột đến vị trí cần 

đặt trên màn hình và nhấp chuột để định vị. 

 

Nhấp phải chuột và chọn lệnh End mode từ menu xổ xuống để thoát khỏi công cụ Place Part (nhấp 

phím Esc trên bàn phím để kết thúc việc đặt linh kiện). Tiếp tục hãy lấy 5 linh kiện điện trở ra bảng thiết kế.  

Nhấp chọn biểu tượng Place Part trên thanh công cụ. Hộp thoại Place Part xuất hiện, trong khung 

Libraries nhấp chọn thư viện Discrete trong khung nằm bên trên khung Libraries, dùng chuột kéo thanh 

trượt lên xuống để tìm và nhấp chọn Resistor. Hình dạng linh kiện điện trở xuất hiện ngay trong cửa sổ 

Preview nằm bên phải Libraries . Nhấp OK để đóng hộp thoại . 
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Sau khi trở về màn hình thiết kế thì hình dạng linh kiện sẽ xuất hiện trên đầu con trỏ chuột. Di chuyển 

chuột đến vị trí cần đặt trên màn hình và nhấp chuột để định vị.Vì cần 5 điện trở nên lần lượt con trỏ chuột 

đến các vị trí khác đồng thời nhấp chuột để đặt đủ 5 linh kiện điện trở. Khi đã đạt đủ 6 linh kiện lên bảng 

thiết kế. Nhấp phải chuột và chọn lệnh End Mode tư  Menu xổ xuống để thoát khỏi công cụ Place Part 

(nhấp phím esc trên bàn phím để kết thúc việc đặt linh kiện). 

Tiếp tục hãy lấy linh kiện Transistor NPN ra bảng thiết kế. Nhấp chọn biểu tượng Place Part trên 

thanh công cụ. 

Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện Discrete trong khung nằm 

bên trên khung Libraries, dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn Transistor. Hình dạng 

linh kiện Transistor xuất hiện ngay trong cửa sổ Preview nằm bên phải Libraries. 

Nhấp OK để đóng hộp thoại. 
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Sau khi trở về màn hình thiết kế thì hình dạng linh kiện sẽ xuất hiện trên đầu con trỏ chuột. Di chuyển 

chuột đến vị trí cần đặt trên màn hình và nhấp chuột để định vị. 

Nhấp phải chuột và chọn lệnh End mode từ Menu xổ xuống để thoát khỏi công cụ Place Part (nhấp 

phím esc trên bàn phím để kết thúc việc đặt linh kiện). 

Tiếp tục hãy lấy linh kiện thạch anh ra bảng thiết kế. Nhấp chọn biểu tượng Place Part trên thanh 

công cụ. 

Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện Discrete trong khung nằm 

bên trên khung Libraries, dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn Crystal. Hình dạng 

linh kiện thạch anh xuất hiện ngay trong cửa sổ preview nằm bên phải Libraries . 

Nhấp OK để đóng hộp thoại . 
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Trở về màn hình thiết kế thì hình dạng linh kiện thạch anh trên đầu con trỏ chuột. Di chuyển chuột đến 

vị trí cần đặt trên màn hình và nhấp chuột để định vị. 

Nhấp phải chuột và chọn lệnh End mode tư  Menu xổ xuống để thoát khỏi công cụ Place Part (nhấp 

phím Esc trên bàn phím để kết thúc việc đặt linh kiện). 

Tiếp tục, nhấp chọn biểu tượng Place Part trên thanh công cụ để lấy cổng NAND. Hộp thoại Place 

Part xuất hiện, trong khung Libraries nhấp chọn thư viện Gate trong khung nằm bên trên khung Libraries, 

dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn 4011. Hình dạng linh kiện NAND 4011 xuất hiện 

ngay trong cửa sổ Preview 

Nằm bên phải Libraries. 

Nhấp OK . 

 

 

 

 

 

Chú ý: nếu trong 

khung Libraries không có 
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thư viện chứa Gate mà ta cần thì hãy nhấp nút Add Libraries để thêm thư viện  

 

Sau khi trở về màn hình thiết kế. Lúc này hình dạng của linh kiện tụ điện sẽ xuất hiện trên đầu con trỏ 

chuột, di chuyển chuột đến vị trí cần đặt trên màn hình và nhấp chuột để định vị. Vì cần 4 cổng NAND nên 

lần lượt trỏ chuột đến các vị trí khác đồng thời nhấp chuột để đặt đủ 4 cổng Nand. Khi đã đạt đủ 4 cổng 

NAND lên bảng thiết kế. Nhấp phải chuột và chọn lệnh End mode tư menu xổ xuống để thoát khỏi công cụ 

Place Part (nhấp phím esc trên bàn phím để kết thúc việc đặt linh kiện). 

Tiếp theo, Nhấp chọn Place Part trên thanh công cụ để lấy loa. 

Hộp thoại Place Part 

xuất hiện, trong khung 

Libraries nhấp chọn thư viện 

Discrete trong khung nằm bên 

trên khung Libraries, dùng 

chuột kéo thanh trượt lên 

xuống để tìm và nhấp chọn 

Speaker. Hình dạng linh kiện 

loa xuất hiện ngay trong cửa sổ 

Preview nằm bên phải 

Libraries. 

Nhấp OK để đóng hộp 

thoại. 

Sau khi trở về màn hình 

thiết kế. Lúc này hình dạng của 

linh kiện loa sẽ xuất hiện trên đầu con trỏ chuột, di chuyển chuột đến vị trí cần đặt trên màn hình và nhấp 
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chuột để định vị. Nhấp phải chuột và chọn lệnh End mode tư menu xổ xuống để thoát khỏi công cụ Place 

Part (nhấp phím esc trên bàn phím để kết thúc việc đặt linh kiện). 

Bây giờ tiến hành lấy các bộ dò kết nối ngỏ ra (đầu dò) và ngõ cung cấp nguồn DC cho mạch cũng như 

các cổng. Nhấp chọn Place Part trên thanh công cụ. 

Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện connector trong khung 

nằm bên trên khung Libraries, dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn CON2. Hình 

dạng bộ kết nối sẽ xuất hiện ngay trong cửa sổ Preview nằm bên phải Libraries. 

Nhấp OK để đóng hộp thoại . 

 

Đưa trỏ chuột đến các vị trí trống trên bản thiết kế và lần lượt nhấp trái chuột 2 lần để đặt 2 bộ kết nối. 

Cuối cùng nhấp vào biểu tượng mass để kết nối các chân linh kiện có chung mass. Nhấp chọn Place 

Ground trên thanh công cụ. 

Hộp thoại Place Ground xuất hiện, trong khung Libraries nhấp chọn thư viện Capsym và  trong 

khung nằm bên trên khung Libraries, dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn Gnd-

Power. Nhấp OK để đóng hộp thoại. 
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Đưa 

trỏ chuột 

đến biểu tượng Mass trên đầu đến các vị trí trống trên bảng thiết kế và nhấp trái chuột để định vị. Nhấn phím 

Esc trên bàn phím để kết thúc. 

Bước tiếp theo việc lấy và đặt linh kiện là di chuyển và sắp xếp các linh kiện cho thích hợp với sơ đồ 

nguyên lý. Nhấp chọn vào linh kiện muốn di chuyển, linh kiện được chọn sẽ được đóng khung. Giữ chuột và 

di chuyển đến vị trí thích hợp trên bản vẽ rồi nhả chuột để định vị linh kiện. Nhấp chuột vào chỗ trống không 

có linh kiện để bỏ chọn linh kiện vừa di chuyển. Lặp lại các bước trên để di chuyển các linh kiện khác đến vị 

trí thích hợp trên bảng thiết kế. 

Trong quá trình di chuyển linh kiện, nếu hướng của linh kiện không nằm đúng thì ta có thể xoay linh 

kiện sang hướng khác phù hợp bằng cách nhấp phải chuột và chọn lệnh rotate từ menu xổ xuống hay nhấn 

phím R trên bàn phím (với điều kiện là ta đã nhấp nhọn linh kiện ) mỗi lần ta sử dụng lệnh trên thì linh kiện 

sẽ xoay 1 góc 900. 

 

Ngoài ra ta cũng có thể lật 1 linh kiện đối xứng theo chiều ngang hay chiều dọc bằng cách nhấp chuột 

để chọn nó, nhấp phải chuột và chọn lệnh Mirror Horizontally hay Mirror Vertically từ Menu xổ xuống. 
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Hình sau đây minh hoạ cho việc quay đối diện linh kiện tương ứng theo chiều ngang và chiều dọc, khi 

sắp xếp linh kiện xong sẽ có vị trí các linh kiện trên bảng thiết kế sau: 

 

Bước kế tiếp tiến hành nối dây giữa các linh kiện. Nhấp chọn biểu tượng place wire trên bảng công cụ 

vẽ hay chọn Place  Wire.  

 

Sau khi chọn lệnh, con trỏ chuột sẽ thay đổi thành hình chữ thập (+). Đưa con trỏ đến chân linh kiện 

muốn nối dây và nhấp chuột để bắt đầu vẽ. 

Di chuyển con trỏ chuột đến chân linh kiện thứ 2 và nhắp đúp để kết thúc điểm cuối dây nối, 1 đường 

dây nối sẽ được vẽ. Trong quá trình di chuyển chuột đến chân linh kiện thứ 2, khi muốn đổi hướng dây nối 

hãy nhắp chuột để tạo góc và di chuyển chuột sang hướng khác. Hình sau minh hoạ việc nối dây đã hoàn tất. 
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Sau khi nối dây, cần phải chỉnh sửa một số chi tiết mạch lại cho thích hợp khi ra thực hiện tạo mạch in. 

Đầu tiên, hãy thực hiện việc đưa các cổng NAND vào cùng 1 IC 4011 bởi về IC 4011 tích hợp bên 

trong nó 4 cổng NAND nên có thể đưa các cổng vào trong cùng 1 IC 4011. Nhấp đúp vào cổng NAND thứ 

nhất hay nhấp chọn cổng NAND, nhấp phải chuột và chọn lệnh Edit Properties từ  Menu xổ xuống. 

Cửa sổ Properties xuất hiện. Từ cửa sổ này, trong cột Referrence, nhấp chuột để sửa thành U1, trong 

cột Designator nhấp vào mũi tên hướng xuống và chọn chữ A. Nhấp chọn biểu tượng Close phía trên góc 

phải màn hình để đóng cửa sổ. 

 

 

 

 

Tiếp 

theo nhấp đúp vào cổng NAND thứ hai, cửa sổ Properties xuất hiện. Từ cửa sổ này, trong cột Referrence, 

nhấp chuột để sửa thành U1, trong cột Designator nhấp vào mũi tên hướng xuống và chọn chữ B. Nhấp 

chọn biểu tượng close phía trên góc phải màn hình để đóng cửa sổ. 
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Tiếp theo nhấp đúp vào cổng NAND thứ ba, cửa sổ Properties xuất hiện. Từ cửa sổ này, trong cột 

Referrence, nhấp chuột để sửa thành U1, trong cột Designator nhấp vào mũi tên hướng xuống và chọn chữ 

C. Nhấp chọn biểu tượng close phía trên góc phải màn hình để đóng cửa sổ. 

 

 

 

 

 

Tiếp theo nhấp đúp vào cổng NAND thứ tư, cửa sổ Properties xuất hiện. Từ cửa sổ này, trong cột 

Referrence, nhấp chuột để sửa thành U1, trong cột Designator nhấp vào mũi tên hướng xuống và chọn chữ 

D. Nhấp chọn biểu tượng close phía trên góc phải màn hình để đóng cửa sổ. 

Trở về màn hình thiết kế hãy quan sát: lúc này các cổng đã thay đổi thứ tự chân cho phù hợp với số 

chân trong IC 4011. 

 

 

 

 

 

 

Kế tiếp hãy sửa đổi các giá trị cho 

các linh kiện bằng cách nhắp đúp chuột vào 

chuỗi giá trị đi theo linh kiện. Hộp thoại 

Display Properties xuất hiện. Trong khung 

Value nhập vào các giá trị và nhấp OK. 

Tương tự cho các linh kiện khác. 
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Đối với các cổng chúng ta còn 1 chỉnh sửa quan trọng, đó là hiển thị các chân nguồn hoạt động của 

chúng mà trong Capture theo mặc định chúng sẽ ẩn. Lần lượt chỉnh sửa từng cột 1, nhấp chuột chọn cổng 

sau đó nhấp phải chuột, chọn lệnh Edit Part từ menu xổ xuống. 

 

Hộp thoại Pin  Properties xuất hiện, trong khung Shape nhấp vào mũi tên hướng xuống và chọn 

Line. Nhấp chuột chọn hộp kiểm tra Pin Visble. Nhấp OK để trở về cửa sổ sửa linh kiện  
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Lúc này cổng NAND trong cửa sổ đã xuất hiện chân nguồn VSS và VDD. Nhấp chuột vào nút close 

của cửa sổ để đóng lại: 

Hộp thoại Save Part instance xuất hiện. Nhấp nút Update Current để chỉ thay đổi đối với Project 

hiện hành. 

 

 

 

 

 

Tiếp tục lặp lại các bước trên để hiển thị chân nguồn của các cổng còn lại. Sau khi đã hoàn thành việc 

hiển thị các chân nguồn, hãy nhấp chọn biểu tượng Place Wire trên bảng công cụ nối dây các chân nguồn 

này để hoàn tất sơ đồ nguyên lý. 
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Sau khi tạo sơ đồ nguyên lý hãy nhấp vào biểu tượng Save Document trên thanh công cụ nằm bên 

dưới các trình đơn để lưu lại. Hãy chọn lệnh File > Save trên Menu. 

 

Một thông báo của capture hỏi ta có muốn lưu lại tất cả hay không. Nhấp OK để chấp thuận. 

 

Tiếp theo là phải tạo tập tin netlist có phần mở rộng *.MNL để liên kết với chương trình layout. Chọn 

biểu tượng Restore ở góc trên bên phải của bảng thiết kế. Chú ý : đừng lầm với biểu tượng  tương tự của 

chương trình Capture  
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Kích hoạt cửa sổ project và nhấp chọn trang sơ đồ. Trước khi tạo netlist cần phải kiểm tra lỗi của sơ 

đồ nguyên lý về dây nối… nhấp chọn biểu tượng Design Rules Check trên thanh công cụ. 

 

Hộp thoại Design Rules Check xuất hiện và nhấp OK để chương trình bắt đầu tự động kiểm tra. 
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Nếu chương trình không có thông báo gì, tức là sơ đồ mạch không có lỗi gì. Nếu có lỗi thì chương 

trình sẽ hiện lên 1 thông báo các lỗi và vị trí lỗi để dễ dàng trở lại sơ đồ mạch để sửa lại 

Sau khi đã kiểm tra lỗi, nhấp chọn biểu tượng Create Netlist để tạo tập tin Netlist. 

 

Hộp thoại Create Netlist xuất hiện.  

 

 

 

 

 

 

 

 

 

 

 

Chọn 

nhãn Layout trong khung Netlist File chương trình sẽ tự động mặc định tạo tập tin Netlist giống với tên tập 

tin Project và lưu trong cùng 1 thư mục. Nhấp OK. 
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Một thông báo của chương trình rằng tập tin Project sẽ được lưu đế tập tin Netlist. Nhấp Ok để tiếp 

tục 

Nhấp vào biểu tượng chương trình ở trên góc trái màn hình và chọn lệnh Close để thoát khỏi chương 

trình Orcad Capture  

 

 

 

 

II. TẠO 

MẠCH IN TỪ SƠ ĐỒ NGUYÊN LÝ BẰNG CHƯƠNG TRÌNH LAYOUT:  

Khởi động chương trình Orcad layout bằng cách từ màn hình desktop của windows chọn start > 

programs > orcad release 9.2 > layout plus. 

 

 

 

 

 

 

 

 

 

 

 

 

Màn 

hình trắng tiền layout xuất hiện với các trình đơn hỗ trợ cho việc tạo và quản lý các tập tin mạch in. 
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Từ trong màn hình tiền layout này nhấp chọn biểu tượng Open new board hay File > New. 

 

Hộp thoại Load Template File xuất hiện. Bên trong hộp thoại này là danh sách các tập tin bản mạch 

với các kích thước mẫu, mặc định chương trình là tập tin DEAULT.TCH, nhấp chuột vào Open để tiếp tục 

 

 

 

 

 

 

 

 

 

 

Hộp thoại Load Netlist Source xuất hiện. Bên trong hộp thoại này hãy chọn tập tin Mach Do Kim loại 

*.MNL 

được tạo ra 

từ chương 

trình vẽ 

mạch 

nguyên lý 

Capture. 

Chọn xong 

nhấp Open. 
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Hộp thoại Save File as xuất hiện yêu cầu hãy nhập đường dẫn tên (trong mục File Name) và thư mục 

để lưu bản mạch sắp được tạo ra. Nhấp nút Save để tiếp tục  

 

Cửa sổ Automatic ECO Utility xuất hiện, bên trong nó có hộp thoại Link Footprint To Component 

xuất hiện thông báo chương trình không thể tìm thấy chân cắm cho linh kiện U1 có tên linh kiện là IC 4011 

nên ta cần phải chọn chân cho IC 4011. Hãy nhấp chuột vào nút link existing footprint to component… 

Để tiến hành chọn. 

Hộp thoại Footprint for IC 4011 xuất hiện cho phép chọn chân cắm cho linh kiện IC 4011. Trong 

khung Libraries của hộp thoại chọn thư viện chân cắm Dip100b và trong khung footprints chọn chân cắm 

mang tên Dip100b/14/W.300/L.800, hình dạng của chân cắm xuất hiện trong cửa sổ ở bên phải. Nhấp ok để 

chấp nhận . 

Chú ý: tất cả các chân cắm linh kiện được chọn, chương trình lưu lại và sẽ áp dụng cho các linh kiện 

tương tự trong các bản mạch thiết kế hiện hành và sau này. 

Sau khi nhấp OK, tiện ích Eco sẽ tiếp tục tự động tìm các chân các chân cắm cho các linh kiện khác có 

trong sơ đồ mạch. Nếu không tìm thấy thì chương trình sẽ xuất hiện thông báo là không thể thấy và ta cần 
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phải tự tìm. Ơ đây chương trình không tìm thấy chân cắm cho loa và bộ dao động là JUMPER100 trong thư 

viện Jumper. 

 Cửa sổ Automatic ECO Utility thi hành xong thì trên màn hình của chương trình xuất hiện toàn bộ 

hình dạng các linh kiện và các dây nối giữa các chân linh kiện. 

Kế tiếp là sắp xếp các linh kiện đặt lên bản mạch sao cho thích hợp, đầu tiên ta có thể xoá các chú 

thích đi theo linh kiện bằng cách chọn biểu tượng Text Tool trên thanh công cụ. 

 

 

 Di chuyển trỏ chuột đến các văn bản và nhấp chuột để chọn nó sau đó nhấn phím Delete trên bàn 

phím để xoá nó. 

Để sắp xếp các loại linh kiện, nhấp chọn biểu tượng Component Tool trên thanh công cụ. 

 

 

Đưa con trỏ chuột đến linh kiện cần sắp xếp, nhấp chuột để chọn nó, di chuyển chuột đến vị trí muốn 

đặt và nhấp chuột để định vị. Trong quá trình di chuyển, ta có thể nhấn phím R trên bàn phím để xoay các 

linh kiện qua hướng khác nhằm tối ưu hoá việc đặt các linh kiện . 

 

Bước tiếp theo là chọn lớp để tạo mạch in. Do mạch này tương đối đơn giản nên có thể định rõ là chỉ 

tạo 1 lớp. Nhấp chọn biểu tượng View Spreadsheet trên thanh công cụ. 

Sau đó chọn lệnh Strategy > Route từ Menu xổ xuống.  

Cửa sổ Route Layer xuất hiện 

 

 

 

 

Trong cột Enabled của cửa sổ này, giữ phím Ctrl và đồng thời nhấp trái chuột để chọn tất cả các lớp 

không muốn tạo trong mạch in, các lớp được chọn sẽ đổi thành màu đen. Sau đó nhấp phải chuột và chọn 

lệnh Properties (hay nhấn phím tắt Ctrl + E ). Hộp thoại Edit Layer Strategy xuất hiện. Nhấp chuột vào 
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hộp kiểm tra Routing Enabled bỏ để tuỳ chọn này. Sau đó nhấp Ok để đóng hộp thoại Edit Layer 

Strategy.  

 

 

 

 

 

 

Lúc 

này cửa sổ 

thông số Route Layer các lớp của cột Enabled mà đã chọn sẽ đổi từ Yes thành No. Nhấp chuột vào biểu 

tượng Close phía trên góc phải hộp thoại để đóng cửa. 

Tiến hành định rõ độ rộng của đường mạch in bằng cách nhấp chọn biểu tượng View Spreadsheet và 

chọn lệnh Nets từ Menu xổ xuống.  

Hộp thoại Nets xuất hiện, trong cột Width hãy nhấp chọn toàn bộ cột này và nhấp phải chuột. Hãy 

chọn lệnh Properties từ Menu xổ xuống. 

Hộp thoại Edit Net xuất hiện. Trong hộp thoại Edit Net nhập các giá trị vào các khung Min Width, 

Conn Width, Max Width tương ứng là 10, 10, 10.  

Nhập xong nhấp Ok để đóng hộp thoại. Lúc này các dòng của cột Width trong cửa sổ Nets xuất hiện 

các con số  vừa nhập. 

 

 

 

 

 

 

 

Tiếp 

tục hãy vẽ khung viền cho bảng mạch nhằm giới hạn kích thước của bảng mạch in, nhấp chọn biểu tượng 

Obstacle Tool trên thanh công cụ. 
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Đưa con trỏ chuột đến vị trí góc trên bên trái của khung muốn vẽ, nhấp chuột để bắt đầu vẽ. Di chuyển 

trỏ chuột sang bên phải để vẽ cạnh thứ nhất. Đến góc thứ hai, nhấp chuột để chọn hướng và di chuyển chuột 

xuống dưới để vẽ cạnh thứ hai. Tiếp tục công việc trên cho đến khi gặp góc kết thúc, nhấp chuột để khép kín 

và nhấp phải chuột chọn lệnh End Command từ Menu xổ xuống. 

Khung đã được vẽ bao quanh bản mạch. 

 

 

 

 

 

 

 

 

Bây 

giờ cho chương trình tự động chạy để tạo mạch in. Nhấp chọn Menu  Auto > Autoroute > Board 

Một thông báo cho biết việc chạy mạch in đã hoàn thành. Nhấp OK để tiếp tục. 

 

 

 

 

Trên màn hình xuất hiện bản mạch in đã được thiết kế hoàn tất và ta có thể nhấp chọn biểu tượng 

Zoom In sau đó nhấp chuột vào bản mạch để phóng to.  

Tuy nhiên hãy quan sát mạch in vừa tạo thành dễ dàng nhận ra rằng vẫn còn các dây nối mạch chưa 

được tự động tạo mạch in. 

Ghi Chú: do quá trình sắp xếp các linh kiện trên bản vẽ chưa được tối ưu hay có thể mạch phức tạp 

nên nếu chạy 1 lớp thì mạch in không hoàn toàn tạo được. Nếu trong quá trình thực hiện bài tập này, với 1 

lớp mạch in được tạo hoàn toàn thì không cần phải thực hiện các bước sau. 
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Để khắc phục đầu tiên ta hãy xoá bỏ các đường mạch in để trả về với các đường nối ban đầu Auto > 

Unroute > Board 

 

Ngay lập tức chương trình sẽ xoá các đường mạch in trên bảng và trả về các đường nối mạch ban đầu. 

Nhấp chọn biểu tượng View Spreadsheet trên thanh công cụ  

Sau đó chọn lệnh Strategy > Route từ Menu xổ xuống.  

Cửa sổ Route Layer xuất hiện 

 

 

 

 

 

 

 

 

Cửa sổ thông số Route Layer xuất hiện để tạo thêm 1 lớp mạch in trong cột Enabled nhấp chọn các 

hàng mang tên Bottom và nhấp phải chuột và chọn lệnh Properties từ  Menu xổ xuống. 

Hộp thoại Edit Layer Strategy xuất hiện. Nhấp chuột vào hộp kiểm tra Routing Enabled bỏ để tuỳ 

chọn này. Sau đó nhấp OK để đóng hộp thoại Edit Layer Strategy.  
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Lúc này cửa sổ thông số Route Layer các lớp của cột Enabled mà ta chọn sẽ đổi từ No thành Yes. 

Nhấp chuột vào biểu tượng Close phía trên góc phải hộp thoại để đóng cửa. 

Bây giờ cho chương trình chạy tự động 1 lần nữa để tạo ra mạch in với 2 lớp: lớp trên và lớp dưới, 

nhấp chọn Menu  Auto > Autoroute >Board 

Một thông báo cho biết việc chạy mạch in đã hoàn thành. Nhấp Ok để tiếp tục. 

Trên màn hình xuất hiện bảng mạch in đã được thiết kế hoàn tất, ta có thể nhấp chọn biểu tượng Zoom 

In sau đó nhấp chuột vào bảng mạch để phóng to.  
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Muốn xem riêng từng đường mạch in bằng cách chọn View > Clear Screen hay nhấn phím 

Backspace trên bàn phím để xáo toàn bộ màn hình và sau đó nhấp phím số 1 trên bàn phím để xem lớp TOP 

(lớp trên). 

 

 

 

 

 

 

 

 

 

 Và phím số 2 để xem lớp BOTTOM (lớp dưới). 

 

 

 

 

 

 

 

 

 

Để trở về tình trạng hiển thị toàn bộ, chọn Menu View > Design. Để kết thúc, hãy nhấp chọn biểu 

tượng Save trên thanh công cụ bên dưới trình đơn để lưu lại toàn bộ bảng mạch in vừa tạo hay vào Menu 

File > Save. 
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Bài 4: MẠCH DAO ĐỘNG DÙNG IC 4011 
 

I. DÙNG CHƯƠNG TRÌNH ORCAD CAPTURE ĐỂ VẼ MẠCH NGUYÊN LÝ: 

 Khởi động chương trình Orcad bằng cách: từ màn hình Desktop của Windows chọn lệnh Start > 

Programs > Orcad Release 9.2 > Capture Cis. 

 

 

 

 

 

 

 

 

Trên 

màn hình xuất hiện biểu tượng Orcad  

 Cửa sổ màn hình trắng của chương trình Capture xuất hiện với các trình đơn hỗ trợ cho việc tạo mới 

và quản lý các Project (dự án).  

 

 

 

 

 

 

Từ cửa sổ màn hình trắng này, nhấp chọn biểu tượng Create Document trên thanh công cụ hay chọn 

File > New > Project để tạo một Project mới. 
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Hộp thoại New Project xuất hiện. Từ trong hộp thoại này, ở mục Create a New Project Using nhấp 

chọn Schematic. Trong mục Name nhập tên Project muốn tạo, trong mục Location chọn nút Browse để 

chọn thư mục muốn chứa tập tin Project.  Chọn xong, nhấp chuột vào nút OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sau khi nhấp 

vào OK lập tức màn 

hình thiết kế thiết kế của Capture xuất hiện với các trình đơn, thanh công cụ định dạng và bảng công cụ vẽ 

và thanh công cụ thiết kế nằm bên dưới các trình đơn. 

Công việc đầu tiên để vẽ sơ đồ nguyên lý là phải lấy các linh kiện đưa lên bảng thiết kế trên màn hình. 

Quan sát sơ đồ ta thấy: 2 tụ điện không phân cực, 8 điện trở,1 transistor pnp, 4 cổng nor, 1 ngõ vào cung cấp 

dc, 1 ngõ ra tín hiệu và biểu tượng mass. 

Trước hết lấy 4 cổng Nor, Nhấp chuột vào biểu tượng Place Part trên thanh công cụ để lấy linh kiện 

hay Place > Part hoặc nhấn tổ hợp phím Shift + P. 

 

 

Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện Gate trong khung Part ở 

trên, dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn 4011. Hình dạng linh kiện tụ điện xuất 

hiện ngay trong cửa sổ Preview nằm bên phải Libraries. 

Nhấp OK để đóng hộp thoại. 
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C 

 

 

 

 

 

 

 

 

 

 

 

 

 

Chú ý: nếu trong khung Libraries không có thư viện chứa linh kiện mà ta cần thì hãy nhấp nút Add 

Libraries để thêm thư viện. Ví dụ trong Libraries không có tên Gate trong khung Libraries, hãy nhấp 

chọn nút Add Library. 

 

 

 

 

 

 

 

Hộp thoại Browse File xuất hiện. Trong hộp danh sách các tập tin thư viện dùng chuột di chuyển 

thanh trượt ngang qua lại để tìm thư viện Gate.Olb, nhấp chuột chọn nó rồi nhấp Open. Lúc này trong 

khung Libraries của hộp thoại Place Part sẽ xuất hiện thêm thư viện Gate mà ta vừa chọn. Đối với các thư 

viện khác mà chưa có trong khung Libraries, cũng làm như trên để thêm vào thư viện chứa linh kiện khác 

cần lấy. 

Sau khi trở về màn hình thiết kế. Lúc này hình dạng của cổng nor sẽ xuất hiện trên đầu con trỏ chuột, 

di chuyển chuột đến vị trí cần đặt trên màn hình và nhấp chuột để định vị, vì cần 4 cổng nor nên lần lượt con 

trỏ chuột đến các vị trí khác đồng thời nhấp chuột để đặt đủ 4 cổng nor. Khi đã đạt đủ 4 cổng nor lên bảng 
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thiết kế. Nhấp phải chuột và chọn lệnh End Mode tư menu xổ xuống để thoát khỏi công cụ Place Part 

(nhấp phím Esc trên bàn phím để kết thúc việc đặt linh kiện). 

Tiếp theo là lấy linh kiện điện trở. Nhấp chọn Place Part trên thanh công cụ. 

Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện Discrete trong khung nằm 

bên trên khung Libraries, dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn R. Hình dạng linh kiện 

điện trở xuất hiện ngay trong cửa sổ Preview nằm bên phải Libraries. Nhấp OK để đóng hộp thoại  

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình 

dạng linh kiện điện trở xuất hiện trên đầu con trỏ chuột, di chuyển chuột đến vị trí cần đặt trên màn hình và 

nhấp chuột để định vị. Trên sơ đồ có 8 điện trở nên hãy di chuyển đến các vị trí khác nhau và đồng thời nhấp 

chuột đặt đủ 8 điện trở. Nhấp phải chuột và chọn lệnh End Mode từ Menu xổ xuống để thoát khỏi công cụ 

Place Part (nhấp phím Esc trên bàn phím để kết thúc việc đặt linh kiện).  

Tiếp tục hãy lấy 2 linh kiện tụ điện không phân cực ra bảng thiết kế. Nhấp chọn biểu tượng Place Part 

trên thanh công cụ. 

Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện Discrete trong khung nằm 

bên trên khung Libraries, dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn Cap Np. Hình dạng 

linh kiện tụ điện xuất hiện ngay trong cửa sổ Preview nằm bên phải Libraries .Nhấp Ok để đóng hộp thoại. 

Sau khi trở về màn hình thiết kế thì hình dạng linh kiện sẽ xuất hiện trên đầu con trỏ chuột, di chuyển 

chuột đến vị trí cần đặt trên màn hình và nhấp chuột để định vị. Vì cần 2 tụ điện nên lần lượt con trỏ chuột 

đến các vị trí khác đồng thời nhấp chuột để đặt đủ 2 linh kiện tụ điện. Khi đã đạt đủ 2 linh kiện lên bảng thiết 
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kế. Nhấp phải chuột và chọn lệnh End Mode từ Menu xổ xuống để thoát khỏi công cụ Place Part (nhấp 

phím Esc trên bàn phím để kết thúc việc đặt linh kiện). 

Tiếp tục hãy lấy linh kiện transistor pnp ra bảng thiết kế. Nhấp chọn biểu tượng Place Part trên 

thanh công cụ. 

Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện transistor  trong khung 

nằm bên trên khung Libraries, dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn 2n4030. Hình 

dạng linh kiện transistor xuất hiện ngay trong cửa sổ Preview nằm bên phải Libraries. Nhấp Ok để đóng 

hộp thoại. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sau 

khi trở về màn hình thiết kế thì hình dạng linh kiện sẽ xuất hiện trên đầu con trỏ chuột. Di chuyển chuột đến 

vị trí cần đặt trên màn hình và nhấp chuột để định vị. Nhấp phải chuột và chọn lệnh end mode từ menu xổ 

xuống để thoát khỏi công cụ Place Part (nhấp phím esc trên bàn phím để kết thúc việc đặt linh kiện). 

Bây giờ tiến hành lấy các bộ kết nối ngõ ra tín hiệu và ngõ cung cấp nguồn DC cho các cổng số hoạt 

động. Nhấp chọn Place Part trên thanh công cụ. 

Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện connector trong khung 

nằm bên trên khung Libraries, dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn Con2. Hình dạng 

linh kiện Con2 xuất hiện ngay trong cửa sổ Preview nằm bên phải Libraries. Nhấp Ok để đóng hộp thoại. 
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Trở 

về màn hình thiết kế thì hình dạng linh kiện sẽ xuất hiện trên đầu con trỏ chuột. Di chuyển chuột đến vị trí 

cần đặt trên màn hình và nhấp chuột để định vị lần lượt nhấp chuột 2 lần để đặt 2 bộ kết nối. Nhấp phím Esc 

trên bàn phím để kết thúc việc đặt linh kiện. 

Cuối cùng nhấp vào biểu tượng Mass để kết nối các chân linh kiện có chung Mass. Nhấp chọn Place 

Ground trên thanh công cụ. 

Hộp thoại Place Ground xuất hiện, trong khung Libraries nhấp chọn thư viện Capsym và trong 

khung nằm bên trên khung Libraries, dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn Gnd 

Power. Nhấp Ok để đóng hộp thoại. 

Đưa trỏ chuột đến biểu tượng Mass trên đầu đến các vị trí trống trên bảng thiết kế và nhấp trái chuột 

để định vị. Nhấn phím Esc để kết thúc. 

Bước tiếp theo việc lấy, đặt linh kiện là di chuyển và sắp xếp các linh kiện hợp với sơ đồ nguyên lý.  

Nhấp chọn vào linh kiện muốn di chuyển, linh kiện được chọn sẽ được đóng khung. Giữ chuột và di 

chuyển đến vị trí thích hợp trên bản vẽ rồi nhả chuột để định vị linh kiện. Nhấp chuột vào chỗ trống không 

có linh kiện để bỏ chọn linh kiện vừa di chuyển. Lặp lại các bước trên để di chuyển các linh kiện khác đến vị 

trí thích hợp trên bảng thiết kế. 

Trong quá trình di chuyển linh kiện, nếu hướng của linh kiện không nằm đúng thì ta có thể xoay linh 

kiện sang hướng khác phù hợp bằng cách nhấp phải chuột và chọn lệnh Rotate từ Menu xổ xuống hay nhấn 
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phím R trên bàn phím(với điều kiện là ta đã nhấp nhọn linh kiện) mỗi lần ta sử dụng lệnh trên thì linh kiện 

sẽ xoay 1 góc 900. 

Ngoài ra ta cũng có thể lật 1 linh kiện đối xứng 

theo chiều ngang hay chiều dọc bằng cách nhấp chuột 

để chọn nó, nhấp phải chuột và chọn lệnh mirror 

horizontally hay mirror vertically từ menu xổ 

xuống. 

 

Hình sau đây minh hoạ cho việc quay đối diện linh kiện tương ứng theo chiều ngang và chiều dọc. Khi 

sắp xếp linh kiện xong ta sẽ có vị trí các linh kiện trên bảng 

thiết kế sau: 

Trước khi nối dây, ta cần phải chỉnh sửa một số chi tiết 

mạch lại cho thích hợp khi ra thực hiện tạo mạch in. 

Đầu tiên, hãy thực hiện việc đưa các cổng nor vào 

cùng 1 IC 4011 bởi về IC 4011 tích hợp bên trong nó 4 cổng nor nên có thể đưa các cổng vào trong cùng 1 

IC 4011. Ta hãy thực hiện như sau: nhấp đúp vào cổng nor thứ 

nhất hay nhấp chọn cổng nor, nhấp phải chuột và chọn lệnh 

Edit Properties từ Menu xổ xuống. 

 

Cửa sổ Properties xuất hiện. Từ cửa sổ này, trong cột Referrence, nhấp chuột để sửa thành U1, trong 

cột Designator nhấp vào mũi tên hướng xuống và chọn chữ A. Nhấp chọn biểu tượng Close phía trên góc 

phải màn hình để đóng cửa sổ. 

 

 

 

 

 

Tiếp 
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theo nhấp đúp vào cổng nor thứ hai, cửa sổ Properties xuất hiện. Từ cửa sổ này, trong cột Referrence, 

nhấp chuột để sửa thành U1, trong cột Designator nhấp vào mũi tên hướng xuống và chọn chữ B. Nhấp 

chọn biểu tượng close phía trên góc phải màn hình để đóng cửa sổ. 

 

 

 

 

Tiếp 

theo nhấp đúp vào cổng nor thứ ba, cửa sổ Properties xuất hiện. Từ cửa sổ này, trong cột Referrence, nhấp 

chuột để sửa thành U1, trong cột Designator nhấp vào mũi tên hướng xuống và chọn chữ C. Nhấp chọn biểu 

tượng Close phía trên góc phải màn hình để đóng cửa sổ. 

 

 

 

 

Tiếp 

theo nhấp đúp vào cổng nor thứ tư, cửa sổ Properties xuất hiện. Từ cửa sổ này, trong cột Referrence, nhấp 

chuột để sửa thành U1, trong cột Designator nhấp vào mũi tên hướng xuống và chọn chữ D. Nhấp chọn biểu 

tượng Close phía trên góc phải màn hình để đóng cửa sổ.  

 

 

 

 

 

Chúng ta còn 1 chỉnh sửa quan trọng, đó là hiển thị các chân nguồn hoạt động của chúng mà trong 

capture theo mặc định chúng sẽ ẩn. Lần lượt chỉnh sửa từng cột 1, nhấp chuột chọn cổng sau đó nhấp phải 

chuột, chọn lệnh Edit Part từ Menu xổ xuống. Cửa sổ sửa linh kiện với cổng mà ta chọn. 

Trong cửa sổ nhắp đúp chuột vào chân ẩn như hình sau: 
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Hộp thoại Pin Properties xuất hiện, trong khung Shape nhấp vào mũi tên hướng xuống và chọn Line. 

Nhấp chuột chọn hộp kiểm tra Pin Visble. Nhấp Ok để trở về cửa sổ sửa linh kiện.  

 

 

 

 

 

 

 

 

Lúc này 

cổng nor trong cửa 

sổ đã xuất hiện chân nguồn Vdd, tiếp tục với chân nguồn Vss. 

Hộp thoại Pin Properties xuất hiện, trong khung Shape nhấp vào mũi tên hướng xuống và chọn line. 

Nhấp chuột chọn hộp kiểm tra Pin Visble. Nhấp Ok để trở về cửa sổ sửa linh kiện. 

Lúc này Cổng Nand trong cửa sổ đã xuất hiện chân nguồn Vdd và Vss. Nhấp chuột vào nút Close của 

cửa sổ để đóng lại. 

Hộp thoại Save Part Instance xuất hiện. Ta nhấp nút Update Current để chỉ thay đổi đối với project 

hiện hành. 
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Tiếp tục lặp lại các bước trên để hiển thị chân nguồn của các cổng còn lại. Lúc này trên bảng mạch 

thiết kế sẽ có các cổng với số thứ tự chân thay đổi và các chân nguồn được hiển thị. 

Sau khi hoàn thành việc hiển thị các chân nguồn, hãy nhấp chọn biểu tượng Place Wire trên bảng 

công cụ nối dây các chân nguồn này để vẽ hoàn tất sơ đồ nguyên lý. 

Sau khi chọn lệnh, con trỏ chuột sẽ thay đổi thành hình chữ thập (+). Đưa con trỏ đến chân linh kiện 

muốn nối dây và nhấp chuột để bắt đầu vẽ. 

Di chuyển con trỏ chuột đến chân linh kiện thứ 2 và nhắp đúp để kết thúc điểm cuối dây nối, 1 đường 

dây nối sẽ được vẽ. Trong quá trình di chuyển chuột đến chân linh kiện thứ 2, khi muốn đổi hướng dây nối 

hãy nhắp chuột để tạo góc và di chuyển chuột sang hướng khác. 

Hình sau minh hoạ việc nối dây đã hoàn tất. 

 

Kế tiếp, hãy sửa đổi các giá trị cho các linh kiện bằng cách nhắp đúp chuột vào giá trị đi theo linh kiện. 

Hộp thoại Display Properties xuất hiện. Trong khung Value, nhập vào các giá trị sau đó nhấp Ok. Tiến 

hành tương tự cho các linh kiện khác. 

 

 

 

 

 

 

 

 

 

 



Trường KTCN Hùng Vương                                                                                    Khoa Điện Tử 

 

Tài liệu học tập và tham khảo môn học orcad    71 

 Sau khi tạo sơ đồ nguyên lý hãy nhấp vào biểu tượng Save Document trên thanh công cụ nằm bên 

dưới các trình đơn để lưu lại. Hãy chọn lệnh File > Save trên Menu. 

 

 

 

 

 

 

Một 

thông báo của Capture hỏi có muốn lưu lại tất cả hay không. Nhấp OK để chấp thuận. Tiếp theo là phải tạo 

tập tin Netlist có phần mở rộng *.MNL để liên kết với chương trình Layout. Nhấp vào biểu tượng Restore 

ở góc trên bên phải của bảng thiết kế.  

Kích hoạt cửa sổ Project và nhấp chọn trang sơ đồ. Trước khi tạo Netlist cần phải kiểm tra sơ đồ 

nguyên lý về dây nối… nhấp chọn biểu tượng Design Rules Check trên thanh công cụ. 

Hộp thoại Design Rules Check xuất hiện và nhấp OK để chương trình bắt đầu tự động kiểm tra. 

Sau khi đã kiểm tra lỗi, nhấp chọn biểu tượng Create Netlist để tạo tập tin netlist. Hộp thoại Create 

Netlist xuất hiện. Chọn nhãn Layout, trong khung Netlist File chương trình sẽ tự động mặc định tạo tập tin 

Netlist giống với tên tập tin Project và lưu trong cùng 1 thư mục. Nhấp OK. 

Một thông báo của chương trình rằng tập tin project sẽ được lưu đế tập tin netlist. Nhấp Ok để tiếp 

tục 
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II. TẠO MẠCH IN TỪ SƠ ĐỒ NGUYÊN LÝ BẰNG CHƯƠNG TRÌNH LAYOUT: 

Khởi động chương trình orcad layout bằng cách từ màn hình desktop của windows chọn start > 

programs > orcad release 9.2 > layout plus. 

Từ trong màn hình tiền layout này nhấp chọn biểu tượng open new board hay file > new. 

Hộp thoại load template file xuất hiện. Bên trong hộp thoại này là danh sách các tập tin bản mạch với 

các kích thước mẫu. Chương trình sẽ để ta có thể tự định kích thước, mặc định chương trình là tập tin 

DEAULT.TCH nhấp chuột vào open để tiếp tục 

Hộp thoại load netlist source xuất hiện. Bên trong hộp thoại này hãy chọn tập tin MẠCH DAO 

ĐỘNG SỐ *.MNL được tạo ra từ chương trình vẽ mạch nguyên lý capture mà ta muốn thiết kế sơ đồ mạch 

in, chọn xong nhấp open. 

Hộp thoại save file as xuất hiện yêu cầu ta hãy nhập đường dẫn tên (trong mục file name) và thư mục 

để lưu bản mạch sắp được tao ra. Nhấp nút save để tiếp tục. 

Sau đó chương trình sẽ chạy tiện ích automatic ECO. Cửa sổ automatic ECO utility xuất hiện, bên 

trong nó có hộp thoại link footprint to component xuất hiện thông báo chương trình không thể tìm thấy 

chân cắm cho linh kiện U1 có tên linh kiện là IC 4001 nên ta cần phải chọn chân cho IC 4001. Hãy nhấp 

chuột vào nút link existing footprint to component……. Để tiến hành chọn. 

 

Hộp thoại footprint for IC 4001 xuất hiện cho phép ta chọn chân cắm cho linh kiện IC 4001. Trong 

khung Libraries của hộp thoại chọn thư viện chân cắm Dip100B và trong khung footprints chọn chân cắm 

mang tên Dip100B/14/W.300/L.800. Hình dạng của chân cắm xuất hiện trong cửa sổ ở bên phải của khung 

Libraries. Nhấp Ok để chấp nhận  
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Chú ý: tất cả các chân cắm linh kiện mà ta chọn được chương trình lưu lại và sẽ áp dụng cho các linh 

kiện tương tự trong các bản mạch thiết kế hiện hành và sau này. 

Sau khi nhấp Ok, tiện ích Eco sẽ tiếp tục tự động tìm các chân các chân cắm cho các linh kiện khác có 

trong sơ đồ mạch. 

 Nếu không tìm thấy thì chương trình sẽ xuất hiện thông báo là không thể thấy và ta cần phải tự tìm. Ơ 

đây chương trình không tìm thấy chân cắm cho transistor Q1 có tên là 2N4030. Nhấp nút link existing 

footprint to component… 

Hộp thoại Footprint for 2N4030 xuất hiện. Trong khung Libraries của hộp thoại dùng chuột kéo 

thanh trượt lên xuống để tìm và nhấp chọn 2N4030 và chọn thư viện chân cắm TO. Trong khung Footprints 

cũng dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn TO202AA. Nhấp Ok để chấp nhận. 

Cửa sổ Automatic ECO utility thi hành xong thì trên màn hình của chương trình xuất hiện toàn bộ 

hình dạng các linh kiện và các dây nối giữa các chân linh kiện. 
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Kế tiếp là sắp xếp các linh kiện đặt lên bản mạch sao cho thích hợp nếu ta có yêu cầu kích thước của 

bản mạch in.  

Đầu tiên ta có thể xoá các chú thích đi theo linh kiện bằng cách chọn biểu tượng Text tool trên thanh 

công cụ.  

Di chuyển trỏ chuột đến các văn bản và nhấp chuột để chọn nó sau đó nhấn phím Delete trên bàn phím 

để xoá nó. 

 

Để sắp xếp linh kiện theo 2 cách : thủ công theo ý ta và nhờ chương trình tự động sắp xếp. Ơ đây, hãy 

nhờ chương trình tự động sắp xếp. Nhấp chọn Menu Auto > Place > Board.  
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Dưới đây là hình ảnh khi 

các linh kiện đã được chương trình tự động sắp xếp. 

 

Tiếp tục hãy vẽ khung viền cho bảng mạch nhằm giới hạn kích thước của bảng mạch in, nhấp chọn 

biểu tượng Obstacle tool trên thanh công cụ. 

 

Đưa con trỏ chuột đến vị trí góc trên bên trái của khung muốn vẽ, nhấp chuột để bắt đầu vẽ. Di chuyển 

trỏ chuột sang bên phải để vẽ cạnh thứ nhất. Đến góc thứ hai, nhấp chuột để chọn hướng và di chuyển chuột 

xuống dưới để vẽ cạnh thứ hai. 

 Tiếp tục công việc trên cho đến khi gặp góc kết thúc, nhấp chuột để khép kín và nhấp phải chuột chọn 

lệnh End command từ menu xổ xuống. Khung đã được vẽ bao quanh bảng mạch. 
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Bước tiếp theo là chọn lớp để tạo mạch in. Do mạch này tương đối đơn giản nên có thể định rõ là chỉ 

tạo 1 lớp. Nhấp chọn biểu tượng View Spreadsheet trên thanh công cụ. Sau đó chọn lệnh Strategy > Route 

Layer từ menu xổ xuống.  

Cửa sổ Route layer xuất hiện liệt kê tất cả các lớp mà chương trình mặc định cho phép tạo ra trong 

bảng mạch in. 

 

Trong cột enabled của cửa sổ này, giữ phím ctrl và đồng thời nhấp trái chuột để chọn tất cả các lớp 

các dòng mang tên inner1 và inner2 để không cho phép 2 lớp này tạo mạch in mà chỉ cho phép 2 lớp Top 

và Bottom. Sau đó ta nhấp phải chuột và chọn lệnh properties (hay nhấn phím tắt ctrl + E ). 

Hộp thoại Edit Layer Strategy xuất hiện. Nhấp chuột vào hộp kiểm tra Routing enabled bỏ để tuỳ 

chọn này. Sau đó nhấp ok để đóng hộp thoại Edit Layer Strategy.  

Lúc này cửa sổ thông số Route layer các lớp của cột Enabled mà ta chọn sẽ đổi từ Yes thành No. 

Nhấp chuột vào biểu tượng Close phía trên góc phải hộp thoại để đóng cửa. 
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Tiến hành định rõ độ rộng của đường mạch in bằng cách nhấp chọn biểu tượng View Spreadsheet và 

chọn lệnh Nest từ  menu xổ xuống.  

Hộp thoại Nest xuất hiện, trong cột Width hãy nhấp chọn toàn bộ cột này và nhấp phải chuột. Hãy 

chọn lệnh Properties từ Menu xổ xuống. 

Hộp thoại Edit Net xuất hiện. Trong hộp thoại Edit Net nhập các giá trị vào các khung Min Width, 

Conn Width, Max Width tương ứng là 15, 18, 20. Nhập xong nhấp OK để đóng hộp thoại. Lúc này các 

dòng của cột Width trong cửa sổ Nets xuất hiện các con số mà ta vừa nhập. Bây giờ cho chương trình tự 

động chạy để tạo mạch in. Nhấp chọn menu Auto > autoroute >board. 

Một thông báo cho biết chạy mạch in đã hoàn thành. Nhấp Ok để đóng hợp thoại. 

Cuối cùng có thể đặt tên bảng mạch và các chú thích mạch. Nhấp chọn biểu tượng Text tool trên thanh 

công cụ, từ trong khung màn hình chương trình, nhấp phải chuột và chọn lệnh New  từ  menu xổ xuống.  

Hộp thoại text edit xuất hiện. 
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Trong khung Type of Text, nhấp chọn tuỳ chọn Free, trong mục Text String, nhập vào chú thích 

“Mach Dao Dong So”và trong khung Layer nhấp chọn mũi tên hướng xuống để chọn lớp Top từ danh sách 

xổ xuống. 

Tương tự cho chú thích ngõ vào VCC và ngõ ra OUT. 

 

Muốn xem riêng từng đường mạch in bằng cách chọn View > Clear screen hay nhấn phím Backspace 

trên bàn phím để xáo toàn bộ màn hình và sau đó nhấp phím số 1 trên bàn phím để xem lớp TOP (lớp trên). 
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Muốn xem lớp BOTTOM (lớp dưới) nhấn phím backspace trên bàn phím để xáo toàn bộ màn hình, 

và phím số 2 để xem lớp BOTTOM (lớp dưới). Để trở về tình trạng hiển thị toàn bộ, chọn Menu view > 

Design. 

 

 

 

 

 

 

Để kết thúc, hãy nhấp chọn biểu tượng Save trên thanh công cụ bên dưới trình đơn để lưu lại toàn bộ 

bảng mạch in vừa tạo hay vào Menu File > Save. 
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Bài 5: VẼ VÀ THIẾT KẾ MẠCH IN MẠCH XÚC XẮC 

I. DÙNG CHƯƠNG TRÌNH ORCAD CAPTURE ĐỂ VẼ MẠCH NGUYÊN LÝ: 

 

Công việc đầu tiên để vẽ sơ đồ nguyên lý sau khi khởi động chương trình orcad là phải lấy các linh 

kiện đưa lên bảng thiết kế trên màn hình.  

Nhấp chuột vào biểu tượng Place Part trên thanh công cụ để lấy linh kiện hay Place > part hoặc nhấn 

tổ hợp phím Shift+P. 

Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện 7400 có chứa linh kiện 

7490 và trong khung bên dưới khung Part, dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn 

7490A. Hình dạng linh kiện tụ điện  xuất hiện ngay trong cửa sổ Preview nằm bên phải Libraries. Nhấp 

OK để đóng hộp thoại. 

Chú y: nếu trong khung Libraries không có thư viện chứa linh kiện mà ta cần thì hãy nhấp nút add 

Libraries để thêm thư viện. 

 Ví dụ trong Libraries không có tên 7400 trong khung Libraries, ta hãy nhấp chọn nút Add Library. 

Hộp thoại Browse File xuất hiện. Trong hộp danh sách các tập tin thư viện dùng chuột di chuyển 

thanh trượt ngang qua lại để tìm thư viện Gate.Olb, nhấp chuột chọn nó rồi nhấp Open. Lúc này trong 

khung Libraries của hộp thoại Place Part sẽ xuất hiện thêm thư viện 7400 mà ta vừa chọn ở bài này chúng 

ta cần các linh kiện được chứa trong các thư viện sau: 7400, Muxdecoder, Microprosessor. Đối với các thư 

viện khác mà chưa có trong khung Libraries, cũng làm như trên để thêm vào thư viện chứa linh kiện khác 

cần lấy. 

Tiếp theo là lấy linh kiện cổng NOR 7405. Nhấp chọn Place Part trên thanh công cụ. 
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Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện 7400 chứa linh kiện trong 

khung ở bên trên khung Libraries dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn 7405. Hay 

cũng có thể nhập 7405 vào khung Part để chọn nhanh hơn. Lúc này hình dạng của linh kiện cổng NOT sẽ 

xuất hiện trong khung bên phải khung Libraries. Nhấp OK để trở về. 

 Hình dạng linh kiện xuất hiện trên đầu con trỏ chuột, di chuyển chuột đến vị trí cần đặt trên màn hình 

và nhấp chuột để định vị. Vì sơ đồ cần 6 cổng NOT, nêu sau khi định vị cổng thứ nhất, nên hãy di chuyển 

đến các vị trí khác nhau và đồng thời nhấp chuột định vị cổng thứ hai. Tương tự cho các cổng còn lại nhấp 

phím Esc trên bàn phím để kết thúc việc đặt linh kiện.  

 Tiếp theo là lấy linh kiện Led. Nhấp chọn Place Part trên thanh công cụ. 
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Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện Discrete chứa linh kiện 

led trong khung ở bên trên khung Libraries dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn Led. 

Lúc này hình dạng của linh kiện led sẽ xuất hiện trong khung bên phải khung Libraries . Nhấp OK để trở 

về. 

 Hình dạng linh kiện xuất hiện trên đầu con trỏ chuột, di chuyển chuột đến vị trí cần đặt trên màn hình 

và nhấp chuột để định vị. Vì sơ đồ cần 7 led, nêu sau khi định vị led thứ nhất, nên hãy di chuyển đến các vị 

trí khác nhau và đồng thời nhấp chuột đặt vị led thứ hai. Tương tự cho các led còn lại, nhấp phím Esc trên 

bàn phím để kết thúc.  

 Tiếp theo là lấy linh kiện điện trở R. Vì sơ đồ cần 8 điện trở, nêu sau khi định vị điện trở thứ nhất, nên 

hãy di chuyển đến các vị trí khác nhau và đồng thời nhấp chuột đặt vị điện trở thứ hai. Tương tự cho các 

điện trở còn lại nhấp phím Esc trên bàn phím để kết thúc việc đặt linh kiện.  

 Tiếp theo là lấy linh kiện công tắc. Nhấp chọn Place Part trên thanh công cụ. 

Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện Discrete, dùng chuột kéo 

thanh trượt lên xuống để tìm và nhấp chọn SW PUSHBUTTON. Lúc này hình dạng của linh kiện công tắc 

xuất hiện trong khung bên phải khung Libraries . Nhấp Ok để trở về. 



Trường KTCN Hùng Vương                                                                                    Khoa Điện Tử 

 

Tài liệu học tập và tham khảo môn học orcad    83 

 

Hình dạng linh kiện nút ấn xuất hiện trên đầu con trỏ chuột, di chuyển chuột đến vị trí cần đặt trên màn 

hình và nhấp chuột để định vị. Nhấp Esc trên bàn phím để kết thúc việc đặt linh kiện.  

Tiếp theo là lấy linh kiện tụ điện CAP NP (không cực tính) và C (có cực tính) có trong thư viện 

DISCRETE. 

 Bây giờ hãy lấy các bộ kết nối 2 chân CON2 có trong thư viện DISCRETE cho ngõ vào nguồn DC 

cung cấp cho mạch hoạt động.. 

Hình dạng linh kiện bộ kết nối 2 chân xuất hiện trên đầu con trỏ chuột, di chuyển chuột đến vị trí cần 

đặt trên màn hình và nhấp chuột để định vị. Nhấp phím esc trên bàn phím để kết thúc việc đặt linh kiện.  

 Cuối cùng của công đoạn lấy và đặt các linh kiện là lấy biểu tượng Mass để khi tạo mạch in, chúng ta 

có một đường nối mass chung. Nhấp chọn Place Ground trên thanh công cụ. Hộp thoại Place Ground xuất 

hiện, trong khung Libraries nhấp chọn thư viện Capsym và trong khung nằm bên trên khung Libraries, 

dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn Gnd power. Nhấp ok để đóng hộp thoại . 

Ta cần  di chuyển và sắp xếp các linh kiện cho thích hợp với sơ đồ nguyên lý. Nhấp chọn vào linh kiện 

muốn di chuyển, linh kiện được chọn sẽ được đóng khung. Giữ chuột và di chuyển đến vị trí thích hợp trên 

bản vẽ rồi nhả chuột để định vị linh kiện. Nhấp chuột vào chỗ trống không có linh kiện để bỏ chọn linh kiện 

vừa di chuyển. Lặp lại các bước trên để di chuyển các linh kiện khác đến vị trí thích hợp trên bảng thiết kế. 

Trong quá trình di chuyển linh kiện, nếu hướng của linh kiện không nằm đúng thì ta có thể xoay linh 

kiện sang hướng khác phù hợp bằng cách nhấp phải chuột và chọn lệnh Rotate từ menu xổ xuống hay nhấn 
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phím R trên bàn phím (với điều kiện là ta đã nhấp nhọn linh kiện) mỗi lần ta sử dụng lệnh trên thì linh kiện 

sẽ xoay 1 góc 900. 

Trước khi nối dây, cần phải chỉnh sửa một số chi tiết mạch lại cho thích hợp khi ra thực hiện tạo mạch 

in. 

Đầu tiên, hãy thực hiện việc đưa các cổng NOT vào cùng 1 IC 7405 bởi về IC 7405 tích hợp bên 

trong nó 6 cổng NOT nên có thể đưa các cổng vào trong cùng 1 IC 7405. Thực hiện như sau: nhấp đúp vào 

cổng NOT thứ nhất hay nhấp chọn cổng NOT, nhấp phải chuột và chọn lệnh Edit Properties từ menu xổ 

xuống. 

Cửa sổ Properties xuất hiện. Từ cửa sổ này, trong cột Referrence, nhấp chuột để sửa thành U2, trong 

cột Designator nhấp vào mũi tên hướng xuống và chọn chữ A. Nhấp chọn biểu tượng Close phía trên góc 

phải màn hình để đóng cửa sổ. 

Tiếp theo nhấp đúp vào cổng not thứ hai, cửa sổ Properties  xuất hiện. Từ cửa sổ này, trong cột 

Referrence, nhấp chuột để sửa thành U2, trong cột Designator nhấp vào mũi tên hướng xuống và chọn chữ 

B. Nhấp chọn biểu tượng Close phía trên góc phải màn hình để đóng cửa sổ. 

Tương tự cho các cổng NOT còn lại với thay đổi trong cột Properties là U2 và trong cột Designator 

tương ứng với là C,D,E,F. 

Chú ý: khi thay đổi danh định của các cổng trong cột Reference, cần chú ý là danh định này không 

được trùng với các danh định của IC khác có trong sơ đồ. Ví dụ ở đây, IC 7490A có danh định là U1 nên 

không thể gán cho danh định của các cổng NOT là U1. 

Đối với các cổng cũng như IC chúng ta còn 1 chỉnh sửa quan trọng, đó là hiển thị các chân nguồn hoạt 

động của chúng mà trong Capture theo mặc định chúng sẽ ẩn. Lần lượt chỉnh sửa từng cột 1, nhấp chuột 

chọn cổng sau đó nhấp phải chuột , chọn lệnh Edit part từ menu xổ xuống. 

Cửa sổ sửa đổi linh kiện xuất hiện với cổng mà vừa chọn. Trong cửa sổ nhắp đúp chuột vào chân ẩn 

như sau: 

Hộp thoại Pin Properties xuất hiện, trong khung Shape nhấp vào mũi tên hướng xuống và chọn Line. 

Nhấp chuột chọn hộp kiểm  Pin Visible. Nhấp Ok để trở về cửa sổ sửa linh kiện  

Tiếp tục với chân GND, lúc này cổng not trong cửa sổ đã xuất hiện chân nguồn VCC và GND. Nhấp 

chuột vào nút Close của cửa sổ để đóng lại. 

Tiếp tục lặp lại các bước trên để hiển thị chân nguồn của các cổng còn lại. 

Đối với IC 7490A cũng thực hiện tương tự để hiển thị các chân nguồn ẩn của nó. Sau khi đã hoàn 

thành việc hiển thị các chân nguồn của tất cả các cổng NOT và IC 7490A, hãy nhấp chọn biểu tượng Place 

Wire trên bảng công cụ nối dây các Kế tiếp hãy sửa đổi các giá trị cho các linh kiện bằng cách nhắp đúp 
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chuột vào chuỗi giá trị đi theo linh kiện. Hộp thoại Display Properties xuất hiện. Trong khung Value nhập 

vào các giá trị và nhấp Ok. Tương tự cho các linh kiện khác. 

Sau khi tạo sơ đồ nguyên lý hãy nhấp vào biểu tượng Save Document trên thanh công cụ nằm bên 

dưới các trình đơn để lưu lại.  

Tiếp theo là phải tạo tập tin Nitlist có phần mở rộng *.MNL để liên kết với chương trình Layout. 

Nhấp vào biểu tượng Restore ở góc trên bên phải của bảng thiết kế. 

Kích hoạt cửa sổ Project và nhấp chọn trang sơ đồ. Trước khi tạo Netlist cần phải kiểm tra sơ đồ 

nguyên lý về dây nối… nhấp chọn biểu tượng Design Rules Check trên thanh công cụ. 

Hộp thoại Design Rules Check xuất hiện và nhấp OK để chương trình bắt đầu tự động kiểm tra. 

 

 

 

 

 

 

 

 

 

 

Nếu 

chương 

trình không thông báo gì, tức là sơ đồ mạch không có lỗi. Nếu có lỗi thì chương trình hiện lên 1 thông báo 

các lỗi và vị trí để ta có thể dễ dàng trở lại sơ đồ để sửa lỗi. Sau khi đã kiểm tra lỗi, nhấp chọn biểu tượng 

Create Netlist để tạo tập tin Netlist. 
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Hộp thoại Create Netlist xuất hiện. Chọn nhãn Layout, trong khung Netlist File chương trình sẽ tự 

động mặc định tạo tập tin Netlist giống với tên tập tin Project và lưu trong cùng 1 thư mục. Nhấp OK. 

 

 

 

 

 

 

 

 

 

Một 

thông báo 

của chương trình rằng tập tin Project sẽ được lưu đế tập tin Netlist. Nhấp OK để tiếp tục 

Nhấp vào biểu tượng chương trình ở trên góc trái màn hình và chọn lệnh Close để thoát khỏi chương 

trình Orcad Capture  

 

 

 

 

 

II. TẠO MẠCH IN TỪ SƠ ĐỒ NGUYÊN LÝ BẰNG CHƯƠNG TRÌNH LAYOUT:  

Khởi động chương trình Orcad Layout bằng cách từ màn hình Desktop của Windows chọn Start > 

Programs > Orcad Raelease 9.2 > Layout Plus. 

Màn hình trắng tiền Layout xuất hiện với các trình đơn hỗ trợ cho việc tạo và quản lý các tập tin mạch 

in. 

Từ trong màn hình tiền Layout này nhấp chọn biểu tượng Open New Board hay File > New. 

Hộp thoại Load Template File xuất hiện. Bên trong hộp thoại này là danh sách các tập tin bản mạch 

với các kích thước mẫu. Chương trình sẽ để ta có thể tự định kích thước, mặc định là tập tin DEAULT.TCH 

nhấp chuột vào Open để tiếp tục 
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Hộp thoại Load Netlist Source xuất hiện. Bên trong hộp thoại này hãy chọn tập tin MACH DAO 

ĐỘNG SỐ *.MNL được tạo ra từ chương trình vẽ mạch nguyên lý Capture mà ta muốn thiết kế sơ đồ mạch 

in. Chọn xong nhấp Open. 

 

 

 

 

 

 

 

 

 

Hộp 

thoại Save 

File As xuất hiện yêu cầu ta hãy nhập đường dẫn tên (trong mục File Name) và thư mục để lưu bản mạch 

sắp được tao ra. Nhấp nút Save để tiếp tục  

Cửa sổ Automatic Eco Utility xuất hiện, bên trong nó có hộp thoại Link Footprint To Component 

xuất hiện thông báo chương trình không thể tìm thấy chân cắm cho linh kiện   D1 có tên linh kiện là IC 

1091QM nên ta cần phải chọn chân cho nó. Đối với chân cắm linh kiện này thì ta có thể tạo mới bằng cách 

nhấp chuột vào nút Create Or Modify Footprint Library. Để tiến hành chọn. 

Một cửa sổ xuất hiện, cho phép tạo mới 1 chân cắm linh kiện, nhấp chọn nút Create New Footprint. 
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Hộp thoại 

Create New 

Footprint xuất hiện, trong khung Name Of 

Footprint nhập vào tên của bộ chân mới. 

Nhấp Ok để chấp nhận. 

Tiếp tục hãy vẽ khung viền cho bộ 

chân cắm, nhấp chọn biểu tượng Obstacle 

Tool trên thanh công cụ. 

Đưa con trỏ chuột đến vị trí góc trên 

bên trái của khung muốn vẽ, nhấp chuột để bắt đầu vẽ. Di chuyển trỏ chuột sang bên phải để vẽ cạnh thứ 

nhất. Đến góc thứ hai, nhấp chuột để chọn hướng và di chuyển chuột xuống dưới để vẽ cạnh thứ hai. 

 Tiếp tục công việc trên cho đến khi gặp góc kết thúc, nhấp chuột để khép kín và nhấp phải chuột chọn 

lệnh End Command từ Menu xổ xuống. 
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Nhấp chọn biểu 

tượng Pin Tool 

trên thanh công 

cụ để di chuyển 

chân cắm đã có 

trên màn hình. 

 

 

 

 

Đưa con trỏ đến giữa chân cắm có sẵn và nhấp trái chuột để chọn, di chuyển chuột để kéo chân cắm 

vào trong khung và nhấp trái chuột để định vị. Từ trong khung màn hình, nhấp phải chuột và chọn lệnh New 

từ Menu xổ xuống. 

Một chân cắm khác xuất hiện trên đầu con trỏ chuột, di chuyển con trỏ chuột để đưa chân cắm này đến 

vị trí trong khung và nhấp chuột để định vị. Nhấp chọn biểu tượng Text Tool trên thanh công cụ. 

Sau đó đưa trỏ chuột đến dòng “& Value” và nhấp chuột để chọn, nhấp phải chuột chọn lệnh 

properties từ menu xổ xuống. 

Hộp thoại Text Edit xuất hiện. 

Trong khung Type Of Text, nhấp chọn tuỳ chọn Free trong mục Text String, nhập vào chú thích 

“Diode”và nhấp Ok. 
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Lúc này trong 

cửa sổ tạo chân cắm linh kiện xuất hiện chân cắm mới. 

Trong cửa sổ tạo chân cắm, nhấp chọn nút Save để lưu lại chân cắm vừa tạo. Hộp thoại Save 

Footprint As… xuất hiện. Trong hộp thoại này, tiến hành thay đổi tên chân cắm trong khung Name Of 

Footprint và nhấp nút Browse để chọn thư viện mà sẽ chứa chân cắm vừa tạo. 

 

 

 

 

 

 

 

 

Hộp thoại 



Trường KTCN Hùng Vương                                                                                    Khoa Điện Tử 

 

Tài liệu học tập và tham khảo môn học orcad    91 

Add Library xuất hiện. Trong khung Look In nhấp vào mũi tên hướng xuống để có thể định đường dẫn 

C:\Program File\ Orcad \ Layout Plus \ Library. Và trong khung liệt kê danh sách chọn thư viện 

Jumper.Llb. Chọn xong nhấp Open. 

Cửa sổ Automatic Eco Utility xuất hiện, nhấp chọn nút Link Footprint To Component …hộp thoại 

Footprint For 1091QM xuất hiện, trong khung Libraries của hộp thoại chọn thư viện chân cắm Jumper và 

trong khung Footprints chọn chân cắm vừa tạo ra. Nhấp Ok để chấp nhận . 

Sau khi nhấp Ok, tiện ích Eco sẽ tiếp tục tự động tìm các chân các chân cắm cho các linh kiện khác có 

trong sơ đồ mạch. 

 Nếu không tìm thấy thì chương trình sẽ xuất hiện thông báo là không thể thấy và ta cần phải tự tìm. Ví 

dụ ở đây chương trình không tìm thấy chân cắm cho linh kiện nút nhấn công tắc SW1. Nhấp nút Link 

Existing Footprint To Component… 

Hộp thoại Footprint For Sw_Pushbutton xuất hiện cho phép chọn chân cắm cho linh kiện. Trong 

khung Libraries của hộp thoại chọn thư viện chân cắm Jumper và trong khung Footprints cũng dùng 

chuột kéo thanh trượt lên xuống để tìm và nhấp chọn Jumper 100. Hình dạng của chân cắm xuất hiện trong 

khung ở bên phải khung Libraries . Nhấp Ok để chấp nhận. 

Nếu sau khi nhấp chọn chân cắm linh kiện mà chương trình yêu cầu cần tìm các chân cắm cho các linh 

kiện khác thì ta vẫn làm theo các bước trên để chọn chân cắm cho các linh kiện tương ứng. 

Sau khi cửa sổ Automatic ECO Utility thi hành xong thì trên màn hình của chương trình xuất hiện 

toàn bộ hình dạng các linh kiện và các dây nối giữa các chân linh kiện. Nhấp chọn biểu tượng Reconnect 

Mode để ẩn các đường nối mạch. 

 

 

 

 

 

 

 

 

Kế 

tiếp là sắp xếp các linh kiện đặt lên bản mạch sao cho thích hợp nếu ta có yêu cầu kích thước của bản mạch 

in. Nhấp chọn biểu tượng Component Tool trên thanh công cụ. 
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Đưa con trỏ chuột đến linh kiện muốn sắp xếp, nhấp chuột để chọn nó, di chuyển chuột đến vị trí muốn 

đặt và nhấp chuột để định vị. Trong quá trình di chuyển, có thể nhấn phím R trên bàn phím để xoay các linh 

kiện qua hướng khác nhằm tối ưu hoá việc đặt các linh kiện . 

Ghi Chú: nên sắp xếp linh kiện trên bảng mạch theo các vị trí như hình sau và phải chú ý thứ tự của 

các linh kiện tương ứng để có thể tạo mạch hiện thị mạch xúc xắc chính xác. 

Cũng có thể xoá các chú thích đi theo linh kiện bằng cách chọn biểu tượng text tool trên thanh công cụ. 

Di chuyển trỏ chuột đến các văn bản và nhấp chuột để chọn nó sau đó nhấn phím Delete trên bàn phím để 

xoá nó. 

Sau khi xoá bớt các chú thích đi theo linh kiện, nhấp chọn biểu tượng Zoom In trên thanh công cụ và 

nhấp chuột vào bảng mạch thiết kế để phóng to bảng mạch. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Bước tiếp 

theo là ta hãy chọn lớp để tạo mạch in. Nhấp chọn biểu tượng View Spreadsheet trên thanh công cụ  

Sau đó chọn lệnh Strategy > Route Layer từ Menu xổ xuống.  

Cửa sổ Route Layer xuất hiện trong cột Enabled của cửa sổ này, giữ phím Ctrl và đồng thời nhấp 

trái chuột để chọn tất cả các lớp không muốn tạo trong mạch in, các lớp được chọn sẽ đổi thành màu đen. 

Sau đó ta nhấp phải chuột và chọn lệnh Properties (hay nhấn phím tắt Ctrl + E). 

Hộp thoại Edit Layer Strategy xuất hiện. Nhấp chuột vào hộp kiểm tra routing enabled để bỏ chọn 

này. Sau đó nhấp Ok để đóng hộp thoại Edit Layer Strategy.  
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Lúc này cửa sổ thông số Route Layer các lớp của cột Enabled mà ta chọn sẽ đổi từ Yes thành No. 

Nhấp chuột vào biểu tượng Close phía trên góc phải hộp thoại để đóng cửa hộp thoại. 

 

Bây giờ có thể cho chương trình tự động chạy để tạo mạch in. Ta có thể cho chương trình tự động chạy 

mạch in. Nhấp chọn Auto > Autoroute > Board. 

Một thông báo cho biết việc chạy mạch in đã hoàn thành. Nhấp Ok để tiếp tục. 

Trên màn hình xuất 

hiện bảng mạch in đã được 

thiết kế hoàn tất và ta có thể 

nhấp chọn biểu tượng Zoom 

In sau đó nhấp chuột vào 

bảng mạch để phóng to.  

 

 

 

 

Tiếp tục hãy vẽ khung 

viền cho bảng mạch nhằm giới hạn kích thước của 

bảng mạch in, nhấp chọn biểu tượng Obstacle Tool 

trên thanh công cụ. 

Đưa con trỏ chuột đến vị trí góc trên bên trái 

của khung muốn vẽ, nhấp chuột để bắt đầu vẽ. Di 

chuyển trỏ chuột sang bên phải để vẽ cạnh thứ nhất. 
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Đến góc thứ hai, nhấp chuột để chọn hướng và di chuyển chuột xuống dưới để vẽ cạnh thứ hai. Tiếp tục 

công việc trên cho đến khi gặp góc kết thúc, nhấp chuột để khép kín và nhấp phải chuột chọn lệnh End 

Command từ Menu xổ xuống. 

Cuối cùng có thể đặt lên bảng mạch các chú thích mạch. Nhấp chọn biểu tượng Text Tool trên thanh 

công cụ 

 

 

 

 

 

 

 

 

 

 

Từ trong khung 

màn hình chương trình, nhấp phải chuột và chọn lệnh New từ Menu xổ xuống. 

Hộp thoại Text Edit xuất hiện. Trong khung Type Of Text, nhấp chọn tuỳ chọn Free, trong mục Text 

String, nhập vào chú thích “MACH XUC XAC”và trong khung Layer nhấp chọn mũi tên hướng xuống để 

chọn lớp Top trong khung Rotate nhập vào 900 để xoay ngang văn bản. Nhập xong nhấp chuột vào nút OK 

để đóng hộp thoại . 

 

Lúc này trên đầu con trỏ xuất hiện khung chữ nhật, di chuyển chuột để đưa khung chữ nhật đến vị trị 

cần đặt trong bảng mạch và nhấp chuột để định vị. 

Tương tự hãy tạo ra các chú thích cho ngõ vào, 

ngõ ra, các chân kết nối nguồn cung cấp DC. 

Muốn xem riêng từng đường mạch in bằng cách 

chọn View > Clear Screen hay nhấn phím Backspace 

trên bàn phím để xáo toàn bộ màn hình và sau đó nhấp 

phím số 1 trên bàn phím để xem lớp TOP (lớp trên). 
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Muốn xem lớp BOTTOM (lớp dưới) nhấn phím Backspace trên bàn phím để xáo toàn bộ màn hình. 

Và phím số 2 để xem lớp BOTTOM (lớp dưới). 

Để trở về tình trạng hiển thị toàn bộ, chọn Menu View > Design. 

Để kết thúc, hãy nhấp chọn biểu tượng Save trên thanh công cụ bên dưới trình đơn để lưu lại toàn bộ 

bảng mạch in vừa tạo hay vào Menu File > Save. 
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Bài 6:THIẾT KẾ MẠCH IN ĐIỀU CHỈNH CÔNG 

SUẤT 
 

I. DÙNG CHƯƠNG TRÌNH ORCAD CAPTURE ĐỂ VẼ MẠCH NGUYÊN LÝ: 

 

 

 

 

 

 

 

 

 

 

 

 

Khởi động chương trình orcad bằng cách: từ màn hình desktop của windows chọn lệnh Start > 

Programs > Orcad Release 9.2 > Capture Cis. 

Trên màn hình xuất hiện biểu tượng Orcad  

 Cửa sổ màn hình trắng của chương trình capture  xuất hiện với các trình đơn hỗ trợ cho việc tạo mới 

và quản lý các Project (dự án).  

 

 

 

 

 

Từ cửa sổ màn hình trắng này, nhấp chọn biểu tượng Create Document trên thanh công cụ hay chọn 

File > New > Project để tạo một Project mới. 

Hộp thoại New Project xuất hiện. Từ trong hộp thoại này, ở mục Create A New Project Using nhấp 

chọn Schematic. Trong mục Name nhập tên Project muốn tạo, trong mục Location chọn nút Browse để 

chọn thư mục muốn chứa tập tin Project. 

 Chọn xong, nhấp chuột vào nút Ok. 
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Sau 

khi nhấp vào OK lập tức màn hình thiết kế thiết kế của Orcad Capture xuất hiện với các trình đơn, thanh 

công cụ định dạng và bảng công cụ vẽ và thanh công cụ thiết kế nằm bên dưới các trình đơn. 

Công việc đầu tiên để vẽ sơ đồ nguyên lý là phải lấy các linh kiện đưa lên bảng thiết kế .  

Nhấp chuột vào biểu tượng Place Part trên thanh công cụ để lấy linh kiện hay Place > Part hoặc nhấn 

tổ hợp phím Shift+P, để lấy linh kiện chính của mạch điện. 

Sau khi nhấp vào nút công cụ Place Part trên, hộp thoại Place Part xuất hiện, hộp này cho phép chọn 

lấy các linh kiện. Phải thực hiện bước này nhiều lần để lấy đủ các linh kiện theo yêu cầu của mạch điện.  

Theo bài này ta có các linh kiện 

sau: 3 điện trở, 1 biến trở, 6 diode, 1 

transistor pnp, 1 transistor npn và 2 bộ 

kết nối chân. Chúng nằm trong các 

thư viện Discrete, transistor 

,connector. 

 

 

Hãy quan sát trong khung 

Libraries theo mặc định thì thư viện 

Discrete đã có sẵn trong khung 
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Libraries, nếu trong thư viện mà chưa có sẵn thì ta hãy thêm vào khung Libraries bằng cách nhấp vào nút 

Add Library. 

Hộp thoại Browse File xuất hiện. Trong hộp danh sách các tập tin thư viện dùng chuột di chuyển 

thanh trượt ngang qua lại để tìm thư viện Transistor.Olb, nhấp chuột chọn nó rồi nhấp Open 

Khi trở về hộp thoại Place Part thì trong khung Libraries sẽ xuất hiện thư viện Transistor, lặp lại 

bước thêm cho các thư viện bị thiếu khác (nếu có) 

Sau khi ta lấy đủ các thư viện cần thiết thì bắt đầu chọn lấy linh kiện Transistor. 

Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện transistor và  trong khung 

part, dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn BC557. Hình dạng linh kiện xuất hiện ngay 

trong cửa sổ preview nằm bên phải Libraries . 

Nhấp Ok để đóng hộp thoại . 

 

 

 

 

 

 

 

 

 

 

 

 

Trở về màn hình thiết kế thì hình dạng linh kiện Transistor trên đầu con trỏ chuột. Di chuyển chuột đến 

vị trí cần đặt trên màn hình và nhấp chuột để định vị. 

Nhấp phải chuột và chọn lệnh end Mode từ Menu xổ xuống để thoát khỏi công cụ Place Part (nhấp 

phím Esc trên bàn phím để kết thúc việc đặt linh kiện). 

Hãy nhấp chọn biểu tượng Place Part trên thanh công cụ để lấy linh kiện Transistor Npn. 
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Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện Transistor và trong khung 

Part, dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn 2N6427. Hình dạng linh kiện xuất hiện 

ngay trong cửa sổ Preview nằm bên phải Libraries. Nhấp OK để đóng hộp thoại. 

 

 

 

 

 

 

 

 

 

 

 

Trở 

về màn hình thiết kế thì hình dạng linh kiện trên đầu con trỏ chuột, di chuyển chuột đến vị trí cần đặt trên 

màn hình và nhấp chuột để định vị. 

Nhấp phải chuột và chọn lệnh End Mode từ Menu xổ xuống để thoát khỏi công cụ Place Part (nhấp 

phím Esc trên bàn phím để kết thúc việc đặt linh kiện). 

Tiếp tục lấy linh kiện Diode, nhấp chọn biểu tượng Place Part trên thanh công cụ để lấy linh kiện  

Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện Discrete và  trong khung 

dưới khung part, dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn Diode. Hình dạng linh kiện 

xuất hiện ngay trong cửa sổ Preview nằm bên phải Libraries . 

Nhấp OK để đóng hộp thoại . 

Trở về màn hình thiết kế thì hình dạng linh kiện trên đầu con trỏ chuột, di chuyển chuột đến vị trí cần 

đặt trên màn hình và nhấp chuột để định vị. Vì sơ đồ nguyên lý cần 6 diode nên hãy tiếp tục di chuyển trỏ 

chuột đến các vị trí khác, tại mỗi vị trí nhấp chuột để đặt các linh kiện Diode còn lại và Nhấp phải chuột và 

chọn lệnh End Mode từ  Menu xổ xuống để thoát khỏi công cụ Place Part  

Tiếp theo là lấy linh kiện điện trở, nhấp chọn biểu tượng Place Part trên thanh công cụ để lấy linh 

kiện  



Trường KTCN Hùng Vương                                                                                    Khoa Điện Tử 

 

Tài liệu học tập và tham khảo môn học orcad    100 

Hộp thoại Place Part xuất hiện, trong khung Libraries nhấp chọn thư viện Discrete và trong khung 

Part nhập vào R, hình dạng linh kiện xuất hiện ngay trong cửa sổ Preview nằm bên phải Libraries. Nhấp 

Ok để đóng hộp thoại. 

Trở về màn hình thiết kế thì hình dạng linh kiện điện trở trên đầu con trỏ chuột, di chuyển chuột đến vị 

trí cần đặt trên màn hình và nhấp chuột để định vị. Vì sơ đồ nguyên lý cần 3 điện trở nên hãy tiếp tục di 

chuyển trỏ chuột đến các vị trí khác, tại mỗi vị trí nhấp chuột để đặt các linh kiện còn lại và Nhấp phải chuột 

và chọn lệnh End Mode từ Menu xổ xuống để thoát khỏi công cụ Place Part. 

 Tương tự, hãy lặp lại các bước chọn lấy linh kiện ở trên để các linh kiện sau: 1 biến trở (Resistor 

Var/Discrete), 2 bộ kết nối, 2 chân dành cho ngõ vào nguồn DC. 

Cuối cùng của công đoạn lấy và đặt các linh kiện là lấy biểu tượng Mass để khi tạo mạch in, chúng ta 

có một đường nối Mass chung. Nhấp chọn Place Ground trên thanh công cụ. 

Hộp thoại Place Ground xuất hiện, trong khung Libraries nhấp chọn thư viện Capsym và  trong 

khung nằm bên trên khung Libraries, dùng chuột kéo thanh trượt lên xuống để tìm và nhấp chọn Gnd 

power. Nhấp OK để đóng hộp thoại. 

Đưa trỏ chuột đến biểu tượng Mass trên đầu đến các vị trí trống trên bảng thiết kế và nhấp trái chuột 

để định vị, nhấn phím Esc để kết thúc. 

Bước tiếp theo việc lấy và đặt linh kiện là di chuyển và sắp xếp các linh kiện cho thích hợp với sơ đồ 

nguyên lý. Nhấp chọn vào linh kiện muốn di chuyển, linh kiện được chọn sẽ được đóng khung. Giữ chuột và 

di chuyển đến vị trí thích hợp trên bản vẽ rồi nhả chuột để định vị linh 

kiện, nhấp chuột vào chỗ trống không có linh kiện để bỏ chọn linh 

kiện vừa di chuyển. Lặp lại các bước trên để di chuyển các linh kiện 

khác đến vị trí thích hợp trên bảng thiết kế. 

Trong quá trình di chuyển linh kiện, nếu hướng của linh kiện 

không nằm đúng thì ta có thể xoay linh kiện sang hướng khác phù hợp bằng cách nhấp phải chuột và chọn 

lệnh rotate từ menu xổ xuống hay nhấn phím R trên bàn phím (với điều kiện là ta đã nhấp nhọn linh kiện ) 

mỗi lần ta sử dụng lệnh trên thì linh kiện sẽ xoay 1 góc 900. 

Ngoài ra ta cũng có thể lật 1 linh kiện đối xứng theo chiều ngang hay chiều dọc bằng cách nhấp chuột 

để chọn nó, nhấp phải chuột và chọn lệnh Mirror Horizontally hay Mirror Vertically từ Menu xổ xuống. 
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Tiếp theo hãy nhấp chọn biểu tượng Place Wire trên bảng công cụ nối dây các chân linh kiện để hoàn 

tất sơ đồ nguyên lý. Sau khi chọn lệnh, con trỏ chuột sẽ thay đổi thành hình chữ thập(+). Đưa con trỏ đến 

chân linh kiện muốn nối dây và nhấp chuột để bắt đầu vẽ. Di chuyển con trỏ chuột đến chân linh kiện thứ 2 

và nhắp đúp để kết thúc điểm cuối dây nối, 1 đường dây nối sẽ được vẽ. Trong quá trình di chuyển chuột đến 

chân linh kiện thứ 2, khi muốn đổi hướng dây nối hãy nhắp chuột để tạo góc và di chuyển chuột sang hướng 

khác. Sau khi nối dây tất cả các chân linh kiện, hãy nhấp phải chuột và chọn lệnh End Wire từ Menu xổ 

xuống để kết thúc. Hình sau minh hoạ việc nối dây đã hoàn tất để tạo nên sơ đồ nguyên lý. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Kế tiếp hãy sửa 

đổi các giá trị cho các linh kiện bằng cách nhắp đúp chuột vào chuỗi giá trị đi theo linh kiện. Hộp thoại 

Display Properties xuất hiện. Trong khung Value nhập vào các giá trị và nhấp OK. Tương tự cho các linh 

kiện khác. 

 

 

 

 

 

 

 

 

 

 

Cuố

i cùng ta có sơ đồ nguyên lý hoàn chỉnh như sau: 
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Sau khi tạo sơ đồ 

nguyên lý hãy nhấp vào biểu tượng Save Document trên thanh công cụ nằm bên dưới các trình đơn để lưu 

lại. Hãy chọn lệnh File > Save trên Menu. 

Một thông báo của Capture hỏi ta có muốn lưu lại tất cả hay không. Nhấp Ok để chấp thuận.  

 

 

 

 

 

 

Tiếp theo 

là phải tạo tập tin Nitlist có phần mở rộng *.MNL để liên kết với chương trình Layout. Nhấp vào biểu 

tượng Restore ở góc trên bên phải của bảng thiết kế để thu nhỏ. 

Nhấp chọn cửa sổ quản lý Project để kích hoạt cửa sổ Project và nhấp chọn trang sơ đồ. Trước khi tạo 

Netlist cần phải kiểm tra sơ đồ nguyên lý về dây nối… nhấp chọn biểu tượng Design Rules Check trên 

thanh công cụ. 

Hộp thoại Design Rules Check xuất hiện và nhấp OK để chương trình bắt đầu tự động kiểm tra. 



Trường KTCN Hùng Vương                                                                                    Khoa Điện Tử 

 

Tài liệu học tập và tham khảo môn học orcad    103 

 

 

 

 

 

 

 

 

 

Nếu 

chương trình không thông báo gì, tức là sơ đồ mạch không có lỗi. Nếu có lỗi thì chương trình hiện lên 1 

thông báo các lỗi và vị trí để ta có thể dễ dàng trở lại sơ đồ để sửa lỗi. 

 

 

 

 

 

 Sau khi đã 

kiểm tra lỗi, nhấp chọn biểu tượng Create Netlist để tạo tập tin Netlist, phải chắc chắn rằng đang kích hoạt 

cửa quản lý Project và chọn trang sơ đồ như sau: 

Hộp thoại Create Netlist xuất hiện. Chọn nhãn Layout, trong khung Netlist File chương trình sẽ tự 

động mặc định tạo tập tin Netlist giống với tên tập tin Project và lưu trong cùng 1 thư mục. Nhấp OK. 
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Một thông 

báo của chương 

trình rằng tập tin Project sẽ được lưu đế tập tin Netlist.  

Nhấp Ok để tiếp tục. 

 

 

 

 

 

Nhấp vào biểu tượng chương trình ở trên góc trái màn hình và chọn lệnh Close để thoát khỏi chương 

trình Orcad Capture  

II.TẠO MẠCH IN TỪ SƠ ĐỒ NGUYÊN LÝ BẰNG CHƯƠNG TRÌNH LAYOUT: 

Khởi động chương trình Orcad Layout bằng cách từ màn hình Desktop của Windows chọn Start > 

Programs > Orcad Raelease 9.2 > Layout Plus. 

Màn hình trắng tiền Layout xuất hiện với các trình đơn hỗ trợ cho việc tạo và quản lý các tập tin mạch 

in. 

Từ trong màn hình tiền layout này nhấp chọn biểu tượng Open New Board hay File > New. 
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Hộp thoại Load Template File xuất hiện. Bên trong hộp thoại này là danh sách các tập tin bản mạch 

với các kích thước mẫu. Chương trình sẽ để ta có thể tự định kích thước, mặc định chương trình là tập tin 

DEAULT.TCH. Nhấp chuột vào Open để tiếp tục. 

 

 

 

 

 

 

 

 

 

 

Hộp thoại 

Load Netlist  Source xuất hiện. Bên trong hộp thoại này hãy chọn tập tin *.MNL được tạo ra từ chương 

trình vẽ mạch nguyên lý Capture mà ta muốn thiết kế sơ đồ mạch in. Chọn xong nhấp Open. 

 

 

 

 

 

 

 

 

Hộp 

thoại Save File As xuất hiện yêu cầu ta hãy nhập đường dẫn tên (trong mục file name) và thư mục để lưu 

bản mạch sắp được tao ra. Nhấp nút Save để tiếp tục  
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Cửa sổ 

Automatic Eco Utility xuất hiện, bên trong nó có hộp thoại Link Footprint To Component xuất hiện 

thông báo chương trình không thể tìm thấy chân cắm cho linh kiện nên ta cần phải chọn chân cắm cho linh 

kiện. Hãy nhấp chuột vào nút Link Existing Footprint To Component……. Để tiến hành chọn. 

Ơ đây hộp thoại yêu cầu ta hãy tìm bộ chân cắm cho linh kiện R4 có tên là Resistor Var 

Đối với biến trở 3 chân, có thể tạo mới 1 bộ chân cắm. Hãy nhắp chọn vào nút Create Or Modifi 

Footprint Library  

 

 

 

 

 

 

 

 

 

 

Một cửa sổ xuất 

hiện, cho phép tạo mới 1 chân cắm linh kiện, nhấp chọn nút Create New Footprint. 

Hộp thoại Create New Footprint xuất hiện, trong khung Name Of Footprint nhập vào tên của “biến 

trở”. Nhấp Ok để chấp nhận . 

Sau khi nhấp Ok để trở về cửa sổ tạo chân linh kiện, nhấp chọn biểu tượng zoom out trên thanh công 

cụ và nhấp chuột vào bảng mạch thiết kế để thu nhỏ bảng mạch 
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Nhấp chọn biểu tượng Pin Tool trên thanh công cụ 

để di chuyển chân cắm đã có trên màn hình. Đưa con trỏ 

đến giữa chân cắm có sẵn và nhấp trái chuột để chọn, di 

chuyển chuột để kéo chân cắm vào trong khung và nhấp 

trái chuột để định vị. 

Từ trong khung màn hình, nhấp phải chuột và chọn 

lệnh New từ Menu xổ xuống. 

Một chân cắm khác xuất hiện trên đầu con trỏ 

chuột, di chuyển con trỏ chuột để đưa chân cắm này đến 

vị trí trong khung và nhấp chuột để định vị. Tương tự cho 

các chân còn lại. 

Tiếp tục hãy vẽ khung viền cho bộ chân cắm, nhấp 

chọn biểu tượng Obstacle Tool trên thanh công cụ. Cho 

bộ chân cắm, nhấn phím 5 để chọn lớp 5 cho khung. 

Đưa con trỏ chuột đến vị trí góc trên bên trái của 

khung muốn vẽ, nhấp chuột để bắt đầu vẽ. Di chuyển trỏ 

chuột sang bên phải để vẽ cạnh thứ nhất. Đến góc thứ hai, nhấp chuột để chọn hướng và di chuyển chuột 

xuống dưới để vẽ cạnh thứ hai. 

 Tiếp tục công việc trên cho đến khi gặp góc kết thúc, nhấp chuột để khép kín và nhấp phải chuột chọn 

lệnh End Command từ Menu xổ xuống. 

Trong cửa sổ tạo chân cắm, nhấp chọn nút Save để lưu lại chân cắm vừa tạo. 

Hộp thoại Save Footprint As… xuất hiện. Trong hộp thoại này, tiến hành thay đổi tên chân cắm trong 

khung Name Of Footprint và nhấp nút Browse để chọn thư viện mà sẽ chứa chân cắm vừa tạo. 

Hộp thoại Add Library xuất hiện. Trong khung look in nhấp vào mũi tên hướng xuống để có thể định 

đường dẫn C:\Program File\ Orcad \ Layout Plus \ Library. Và trong khung liệt kê danh sách chọn thư 

viện Jumper.Llb chọn xong nhấp Open. 
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Hộp 

thoại Save 

Footprint As… xuất hiện. Nhấp Ok để chấp nhận. 

Nhấp nút Close để đóng nó lại. Trở về cửa sổ Automatic Eco Utility, nhấp nút Link Existing 

Footprint To Component… 

Hộp thoại Footprint For Resistor Var xuất hiện. Trong khung Libraries của hộp thoại chọn thư viện 

chân cắm Jumper và trong khung Footprints chọn chân cắm vừa tạo ra. Nhấp Ok để chấp nhận. 

Tương tự khi chương trình yêu cầu chọn các linh kiện còn lại thì hãy chọn cho chúng giống như các 

bước chọn như trên. 

Ví dụ chân cắm cho linh kiện điện trở là jumper400 trong thư viện jumper, diode có thể là Jumper500 

trong thư viện Jumper, bộ lết nối 2 chân là Jumper100 trong thư viện Jumper. 

Muốn sắp xếp linh kiện trong 1 không 

gian rộng, hãy nhấp vào biểu tượng 

Reconnect Mode trên thanh công cụ: 

Khi đó các linh kiện xuất hiện không 

có dây nối như sau: 

Tuy nhiên trên bảng mạch lúc này có 

rất nhiều văn bản chú thích đi theo linh 

kiện, để có thể quan sát bảng mạch được rõ 

ràng hơn thì hãy xoá bớt các dòng chú thích 

này khỏi bảng mạch, chỉ để lại tên linh kiện. Nhấp chọn biểu tượng text tool trên thanh công cụ. 
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Sau đó đưa trỏ chuột đến văn bản muốn xoá, nhấp chuột chọn nó và nhấn phím Delete trên bàn phím 

để xoá. 

Kế tiếp là sắp xếp các linh kiện đặt lên bản mạch sao cho thích hợp nếu ta có yêu cầu kích thước của 

bản mạch in.  

Nhấp chọn biểu tượng Component Tool trên thanh công cụ. 

Đưa con trỏ chuột đến linh kiện muốn sắp xếp, nhấp chuột để chọn nó, di chuyển chuột đến vị trí muốn 

đặt và nhấp chuột để định vị. Trong quá trình di chuyển, có thể nhấn phím R trên bàn phím để xoay các linh 

kiện qua hướng khác nhằm tối ưu hoá việc đặt các linh kiện. 

Bước tiếp theo là ta hãy chọn lớp để tạo mạch in. Nhấp chọn biểu tượng View Spreadsheet trên thanh 

công cụ  

 Sau đó chọn lệnh Strategy > Route Layer từ Menu xổ xuống.  

Cửa sổ Route Layer xuất hiện ta nhấp chọn tất cả các mục Yes trong cột enabled của cửa sổ này của 

các ô Bottom, Inner1, Inner2 theo chiều ngang như hình để không cho phép các lớp này được tạo ra trong 

mạch in Sau đó ta nhấp phải chuột và chọn lệnh Properties (hay nhấn phím tắt CTRL + E ) 

Hộp thoại Edit Layer Strategy xuất hiện. Nhấp chuột vào hộp kiểm tra Routing Enabled để bỏ chọn 

này. Sau đó nhấp Ok để đóng hộp thoại Edit Layer Strategy.  

Lúc này cửa sổ thông số Route Layer các lớp của cột Enabled mà ta chọn sẽ đổi từ Yes thành No. 

Nhấp chuột vào biểu tượng Close phía trên góc phải hộp thoại để đóng cửa hộp thoại. 

 

 

 

 

 

 

 

Tiế

n hành 

đinh rõ độ rộng của đường mạch in bằng cách nhấp chọn biểu tượng View Spreadsheet và chọn lệnh Nest 

từ Menu xổ xuống.  
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Hộp thoại Nest xuất hiện, trong cột Width mang giá trị biểu diễn độ rộng đường mạch in, hãy giữ 

phím Ctrl và nhấp chuột chọn tất cả các dòng trong cột Width. Sau khi chọn tất cả các dòng của cột Width, 

hãy nhấp phải chuột và chọn Properties từ Menu xổ xuống. 

Hộp thoại Edit Net xuất hiện. Trong hộp thoại Edit Net nhập các giá trị vào các khung Min Width, 

Conn Width,Max Width tương ứng.  

Nhập xong nhấp Ok để đóng hộp thoại. Lúc này các dòng của cột Width trong cửa sổ Nets xuất hiện 

các con số mà ta vừa nhập. 

 

 

 

 

 

 

 

 

Bây giờ cho chương trình tự động chạy để tạo mạch in, nhấp chọn Menu Auto > Autoroute >Board. 

Sau một lúc, một thông báo cho biết việc chạy mạch in đã hoàn thành. Nhấp OK để tiếp tục. 

 

 

 

 

 

 

 

 

 

 

Trên 

màn hình xuất hiện bản mạch in đã được thiết kế hoàn tất và ta có thể nhấp chọn biểu tượng Zoom In sau đó 

nhấp chuột vào bảng mạch để phóng to. Nhận thấy mạch in được tạo ra như sau: 

Tiếp tục hãy vẽ khung viền cho bảng mạch nhằm giới hạn kích thước của bản mạch in, nhấp chọn biểu 

tượng Obstacle Tool trên thanh công cụ. 
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Đưa con trỏ chuột đến vị trí góc trên bên trái của khung muốn vẽ, nhấp chuột để bắt đầu vẽ. Di chuyển 

trỏ chuột sang bên phải để vẽ cạnh thứ nhất. Đến góc thứ hai, nhấp chuột để chọn hướng và di chuyển chuột 

xuống dưới để vẽ cạnh thứ hai. 

 Tiếp tục công việc trên cho đến khi gặp góc kết thúc, nhấp chuột để khép kín và nhấp phải chuột chọn 

lệnh End Command từ Menu xổ xuống. Cuối cùng có khung đã được vẽ bao quanh bảng mạch. Cuối cùng 

có thể đặt lên bản mạch các chú thích mạch. Nhấp chọn biểu tượng Text Tool trên thanh công cụ 

Từ trong khung màn hình chương trình, nhấp phải chuột và chọn lệnh New  từ Menu xổ xuống.  Hộp 

thoại Text Edit xuất hiện. 

Trong khung Type Of Text, nhấp chọn tuỳ chọn Free, trong mục Text String, nhập vào chú thích 

“MACH DIEU CHINH CONG 

SUAT” cho mạch in và trong 

khung line width có thể định bề 

rộng cho chữ, còn tại khung Text 

Hieght hãy nhập chiều cao chữ. 

Tại hộp Layer nhấp chọn mũi tên 

hướng xuống để chọn lớp TOP từ 

danh sách xổ xuống. Nhấp OK để 

tiếp tục. 

Khi Hộp thoại Text Edit 

đóng, khung chữ nhật xuất hiện tại 

đầu trỏ chuột, di chuyển chuột đế vị trí thích hợp trong mạch in và nhấp chuột để định vị.  

Tương tự hãy đặt các bước như trên để cho chú thích ngõ ra OUT. 

Nếu muốn chỉ thấy các đường mạch hiển thị để tiện việc kiểm tra và in ấn, thì bằng cách ta  chọn View 

> Clear Screen hay nhấn phím Backspace trên bàn phím để xoá toàn bộ màn hình và sau đó nhấp phím số 

1 trên bàn phím để xem lớp TOP (lớp trên). 

Muốn xem lớp BOTTOM (lớp dưới) nhấn phím Backspace trên bàn phím để xáo toàn bộ màn hình. 

Và phím số 2 để xem lớp BOTTOM (lớp dưới). 
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Để trở về tình trạng hiển thị toàn bộ, chọn Menu View > Design. 

Để kết thúc, hãy nhấp chọn biểu tượng Save trên thanh công cụ bên dưới trình đơn để lưu lại toàn bộ 

bản mạch in vừa tạo hay vào Menu File > Save. 
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Bài 7: SỰ LIÊN THÔNG GIỮA CAPTURE CIS VÀ 

PSPICE 
I. QUY TRÌNH DÙNG PSPICE ĐỂ MÔ PHỎNG MỘT SƠ ĐỒ MẠCH ĐIỆN: 

Để Mô phỏng một sơ đồ mạch điện, trước hết phải vẽ sơ đồ mạch điện trong trang vẽ của Capture 

CIS, khi vẽ phải chọn các linh kiện đã có khai báo đủ các thông số kỹ thuật. Sau khi vẽ xong ta chọn dạng 

phân tích,  Pspice sẽ cho chúng ta ba dạng phân tích thường dùng, đó là: 

❖ Phân tích BIASPOINT để hiện kết quả giá trị điện áp và dòng điện trên mạch nguyên lý. 

❖ Phân tích .AC để hiện kết quả của đường cong biên tần và pha tần. 

❖ Phân tích .TRANS để hiện kết quả dạng tín hiệu. 

II. MÔ PHỎNG MẠCH KHUẾCH ĐẠI TÍN HIỆU NHỎ RÁP VỚI HAI TRASISTOR 2SC1815: 

Mở Orcad và vẽ sơ đồ mạch điện trong trang vẽ Capture CIS . 

Để mở nhanh  trang vẽ Capture CIS, ta nhắp Double Click trên tiêu hình sau : 

 

Sau khi vào trang vẽ Capture CIS, chọn mục File, rồi chọn New và Project. Ta sẽ thấy hiện ra cửa sổ 

giao diện như hình sau: 

Trong cửa sổ này ta gõ 

vào tên tập tin (thí dụ: BT – 1 ) 

và chọn dấu ở mục Analog or 

Mixed Signal Circuit Wizard. 

Mục này sẽ cho sơ đồ mạch điện vẽ trong trang Capture CIS liên thông với trình Pspice để mô phỏng tính 

toán tham số của mạch điện. 

Chọn xong ta nhấn OK trên trên phím. 

Trên màn đèn hiện ra cửa sổ giao diện New Project dùng mở một tập tin trong trang Capture CIS và 

rồi sẽ chạy mô phỏng trong trình Pspice. 

Trong ô trống Name, ta nhập vào tên tập tin. 

Trong ô trống Location, ta chọn thư mục dùng để chứa các tập tin hiện dùng. Sau khi chọn định xong 

nhấn phím OK. 
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Các bước thực hiện: 

Bước 1: Dùng lệnh Place Part (gõ phím “P”) để lấy các linh kiện trong các thư viện đặc vào trang về. 

Lúc đặt các linh kiện ta có thể dùng phím “R” để chọn quay các linh kiện . Nên chọn các linh kiện có 

khai báo tham số  để có thể chạy trình Pspice tính toán mạch điện . 

Bước 2: Dùng lệnh Place Wire (gõ phím “W” ) để đặt các đường nối mạch qua các chân của linh kiện . 

Bước 3: Dùng lệnh Place Grund (gõ phím “G”) để đặc dấu Mass cho sơ đồ mạch điện. Với mạch điện 

mô phỏng ban phải dùng ký hiệu đường Mass có số 0. 

Bước 4: Dùng lệnh Edit để soạn lại trị số của các linh kiện. Ta cho con trỏ chỉ ngay trị số  linh kiện, 

nhấp chuột Double Click để mở cửa sổ và gõ vào ô Value trị số của linh kiện mà ta muốn chọn, nhấn 

phím OK. Sau khi vẽ xong sơ đồ mạch điện, ta sẽ thấy kết quả như hình sau: 

 

 

 

 

 

 

 

 

 

 

 

Bước 5: Mở trình Pspice để chọn mô phỏng mạch điện. Để mô phỏng mạch điện này ta phải mở trình 

Pspice bằng cách chọn: New Simulation Profile. Trong cửa sổ New Simulation, nhập vào tên mục 

phân tích . 
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Thí dụ : Gõ 

vào ô Name một cái tên bất kỳ và rồi chọn phím Greate. Ta sẽ thấy hiện ra cửa sổ giao diện như  hình 

sau: 

 

 

 

 

 

 

 

 

 

 

Trong ô 

Analysit Type ta chọn mục Bias Point. Mục Bias Point dùng xác định các mức áp trên mạch và tính 

cường độ dòng điện chảy qua các nhánh. 

Sau khi chọn xong mục này, ta trở lại trang vẽ và nhấn tiêu hình sau để cho chạy trình Pspice. 

Tiêu hình dùng chạy trình Pspice để tính toán và cho ra các kết quả 

từ mạch điện trang vẽ của Capture CIS. Sau khi tính toán xong, 

ta sẽ có kết quả về các mức áp trên các nút nối, các mức áp này 

tính với đường Mass  (Mass là 0V), hãy nhấn trên phím tiêu 

hình bên, ta sẽ thấy kết quả hiện ra: 
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Và hãy nhấp chuột vào tiêu hình sau để xem dòng điện chảy qua các nhánh của 

mạch điện. Kết quả như sau: 

 

 

 

 

 

 

Sau khi thấy được điều kiện phân cực DC cho mạch (đã chạy xong phân tích Bias Point). Ta có thể 

chuyển qua khảo sát mạch điện với nguồn tín hiệu kích thích mạch. Hãy thêm các tụ điện vào mạch và đặc 

nguồn tín hiệu dạng Sin dùng kích thích mạch khuếch đại, sơ đồ mạch điện hoàn chỉnh như hình sau : 

 

 

 

 

 

 

 

 

 

 
V2 nguồn tín hiệu 
kích thích mạch. 
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Hãy cho kích thích mạch với nguồn tín hiệu dạng Sin có biên độ luôn là 1V AC, tần số của tín hiệu sẽ 

thay đổi theo chọn định trong cửa sổ Analysis. 

 

 

Ta nhấp chuột trên tiêu đề Edit Simulation Settings và sẽ thấy hiện ra cửa sổ giao diện Simulation 

Setting … trong mục Analysis type, ta chọn dòng AC.  

 

 

 

 

 

 

 

 

 

Trong khung 

AC 

Sweep/Noise và rồi trong ô Start Frequency, ta gõ vào tần số khởi đầu quét (Thí Dụ :cho quét ở tần số là 

10Hz) ở ô End Frequency ta gõ vào tần số kết thúc quét (Thí Dụ: cho kết thúc ở tần số là 1Meg). Bước 

tính Points/ Decade là trong một bước 10 cho tính 50 điểm. Sau khi chọn xong nhấn OK và chọn chạy 

trình  Pspice để tìm kết quả: 

Sau khi tính xong. Ta hãy đặt ống dò điện áp (Voltage Marker) ở ngõ ra và sẽ thấy kết quả là đường 

cong biên tần hiện ra trên trang đồ thị Simulation, có hình dạng như sau: 
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Phân tích 

đường cong biên tần ta sẽ thấy được độ lợi của mạch khuếch đại lấy trên các tần số khác nhau của tín 

hiệu (với một tần số trên trục ngắn, ta sẽ tính được một mức biên độ ngã ra theo trục dọc, tỉ số biên độ 

ngõ ra và ngỏ vào chính là độ lợi của mạch khuếch đại). 

Đường cong biên tần cho thấy, Khi tần số càng tăng cao thì độ lợi của mạch càng giảm xuống  thấp và 

đường cong cũng cho thấy mạch cho độ lợi rất lớn ở vùng tần số thấp. 

Bây giờ, hãy cho kích thích mạch với một nguồn tín hiệu khác, có biên độ luôn thay đổi theo dạng Sin, 

tần số của tín hiệu sẽ lấy cố định là 1khz, biên độ khoản 10mV. Sơ đồ mạch điện vẽ lại như sau : 

R6 là điện 
trở tải 
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Ta hãy nhấp chuột trên tiêu hình Edit Simulation Settings và sẽ thấy hiện ra cửa sổ giao diện  

Simulation  Setting… trong mục Analysis Type, ta chọn dòng Time Domain (Transient) để khảo sát 

dạng tín hiệu trên các điểm nối của mạch khuếch đại. Trong ô Run To Time, ta gõ vào 3ms (để xem 

được 3 chu kỳ của tín hiệu). Trong ô Start Saving Data After, Ta gõ vào số 0 để cho bắt đầu ghi kết 

quả từ gốc số 0. Trong ô Maxium Size ta gõ vào con số định bước tính.  

Thí Dụ: cho tính theo bước 0.01ms. Gõ xong nhấn phím OK. Bây giờ cho chạy trình Pspice, sau một 

lúc ta sẽ thấy kết quả : 

 

 

 

 

 

 

 

 

 

Nhìn 

vào đồ thị, Ta thấy tín hiệu ngõ ra cũng có dạng giống Sin, biên độ trên cao khoản 2V và biên độ dưới 

khoản –2.5V. Lúc này trục X lấy theo thời gian và trục Y lấy theo biên độ, vậy ở mỗi lúc ta đều có thể 

xác định được biên độ tín hiệu, dĩ nhiên ta cũng có thể dùng ống dò điện áp để xem 

tín hiệu trên bất cứ nút nào của mạch. Tín hiệu ra cho thấy đã bị méo. Để khảo sát 

tính méo của tín hiệu ở ngõ ra, ta có thể mở xem trang đồ thị Fourier. 

Ta chọn tiêu hình sau để mở trang đồ thị Fourier ở đồ thị này, một nguồn tín hiệu dạng Sin chuẩn sẽ 

xuất hiện với một vạch phổ tần duy nhất. Vậy nếu một tín hiệu xuất hiện cùng lúc với nhiều vạch phổ 

biên tần, điều đó cũng có nghĩa là tín hiệu không thuần dạng Sin, hay tín hiệu Sin khi qua mạch khuếch 

đại đã bị méo dạng. 

Đồ thị phân tích chuỗi khai triển Fourier cho thấy có nhiều vạch tín hiệu hơn là chỉ một vạch tín hiệu 

duy nhất đối với nguồn tín hiệu dạng Sin ở ngõ vào. Vậy tín hiệu thuần Sin sau khi qua mạch khuếch 

đại trên đã bị méo. 

III. KẾT LẠI: 
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Để phân tích sơ đồ mạch điện, ta cho vẽ sơ đồ mạch điện trong trang Capture CIS. Lúc vẽ chỉ chú ý 

đến các linh kiện đã khai báo thông số. Lúc bắt đầu ta chạy lệnh BIAS POINT để xác định trạng thấy 

phân cực DC của mạch, khi điều kiện phân cực đã lấy đúng, lúc đó mới gắn vào mạch nguồn tín hiệu dạng 

Sin có biên độ cố định (thường thấy là 1vAC), Chạy lệnh AC Sweep để cho tín hiệu biên độ ngõ ra theo 

trục tần số của tín hiệu Sin và vẽ ra một đường cong biên tần. Nhìn vào đường cong biên tần, chúng ta biết 

được độ lợi của mạch trên từng tần số. Sau đó thay nguồn tín hiệu dạng Sin với tần số cố định (lấy 1KHz), 

biên độ tín hiệu luôn thay đổi và chạy lệnh Transient để tính biên độ của tín hiệu theo trục thời gian, kết 

quả chúng ta sẽ có dạng tín hiệu trên các nút nối, nhìn dạng tín hiệu ngõ ra so với dạng tín hiệu ngõ vào 

chúng ta sẽ biết được tín hiệu sau khi qua mạch khuếch đại có bị méo hay không? Để thấy rõ vấn đề hơn 

có thể mở trang phổ tần Fourier. 

IV. SỰ TƯƠNG QUAN GIỮA CÁC LINH KIỆN TRONG CAPTURE CIS VÀ TRÌNH PHÂN 

TÍCH MẠCH PSPICE: 

Trong Capture Cis, chúng ta biết trên trang vẽ của Capture Cis là các sơ đồ mạch điện nguyên lý. 

Trong đó chỉ gồm có các ký hiệu linh kiện, và các đường nối mạch. Một ký hiệu của một linh kiện sẽ gồm 

có phần hình vẽ (thường có tính tuỳ ý) và các chân hàn (phải có tính quy định chặt chẽ). Thí dụ: một 

Transistor Q2SC1815 sẽ có ký hiệu như hình sau: 

 

 

 

 

 

 

 

 

❖ Transist

or Q2SC1815 có 3 chân, mỗi chân đều phải có 4 thuộc tính, đó là: 

▪ Name: tên của chân. 

▪ Number: số của chân. 

▪ Shape: hình dạng của chân. 

▪ Type: kiểu loại của chân. 
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Chúng ta biết phần hình vẽ của các ký hiệu có tính bất kỳ, nghĩa là ta muốn vẽ kiểu hình gì cũng 

được, miễn sao nó có tính gợi ý cao là tốt. 

Một ký hiệu như vậy, nếu ta không có thêm những chú ý đặc biệt nào nữa thì nó sẽ chỉ là một hình 

vẽ dùng trong các sơ đồ mạch điện nguyên lý mà thôi. Với Orcad 9.2 để một ký hiệu liên thông được với 

trình Layout Plus. Ta phải chú ý tính tương hợp giữa các số chân của linh kiện với số chân của các 

Footprint. Còn một ký hiệu linh kiện muốn liên thông được với trình Pspice, nó phải có thư viện tương 

ứng trong đó chứa các thông số của linh kiện đó. Chúng ta biết khi chạy trình phân tích Pspice, Pspice sẽ 

tìm thấy các thông số này đặt vào các công thức để tính toán. 

Vậy thế nào là 1 ký hiệu linh kiện liên thông với trình Pspice? 

Ta hãy cho chọn linh kiện đó trên trang vẽ của Capture Cis, rồi chọn mục Edit trên thanh Menu 

chính và rồi chọn mục Part. Ta vào trang Edit Part, lúc này hãy chọn mục Options trên thanh Menu 

chính và trong cửa sổ lệnh chọn mục Part Properties. Ta sẽ thấy mở ra một cửa sổ như hình sau: 

 

 

 

 

 

 

 

Tr

ong cửa sổ User Properties, có mục Pspice Template với một dãy khai báo các biến. Dấu hiệu này cho 

biết linh kiện mà ta đang dùng có thể dùng với trình Pspice. Với các ký hiệu linh kiện không có dòng khai 

báo này, ta sẽ không thể dùng để liên thông thẳng với trình Pspice để cho mô phỏng mạch được. 
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Bài 8: MÔ PHỎNG IC 555 

I.VẼ SƠ ĐỒ NGUYÊN LÝ: 

Sau khi mở trình orcad 9.2 lên. Ta hãy chọn mục File, rồi chọn mục New  và chọn mục Project … ta 

sẽ thấy hiện ra một cửa sổ. 

Trong cửa sổ này, ta hãy gõ vào tên tập tin (trong ô Name) và chọn thư mục để Chứa tập tin này 

(trong ô Location). 

 

 

 

 

 

 

 

 

 

 

 

Nếu 

muốn liên thông với trình Pspice thì đánh dấu trong ô tròn thứ nhất . 

Nếu muốn liên thông với trình  Layout Plus để vẽ bản mạch in thì đánh dấu trong ô tròn thứ hai. 

Nếu muốn liên thông với trình PLD dùng để nạp chương trình vào các IC EPROM thì đánh dấu 

trong ô tròn thứ ba. 

Và nếu chỉ muốn vẽ sơ đồ mạch điện thôi, ta đánh dấu ô tròn thứ tư. 

Sau khi chọn song phần mềm cho liên thông với mạch điện vẽ trong trang Capture. 

Ta nhấn phím OK lúc này trình  Capture CIS sẽ mở ra. Để vào ngay trang vẽ, việc thêm bớt các thư 

viện sau này làm cũng được. 

Sau khi nhấn phím Finish, ta sẽ vào khung làm việc chính của trang Capture CIS. Trong vùng làm 

việc này, ta hãy dùng lệnh Place để đặt các thành phần của một mạch điện trên trang vẽ. Ở đây, bạn có thể 
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dùng chuột để sắp xếp lại bản tiêu hình công cụ, ở bản tiêu hình này mỗi tiêu hình sẽ ứng với một chức 

năng cụ thể. 

 

 

 

 

Để 

lấy các ký hiệu từ các thư viện đặc vào trang vẽ, Ta chọn tiêu hình sau:(nhấp con 

trỏ lên tiêu hình Place Part. 

Lúc này ta sẽ thấy hiện ra một giao diện: trong giao diện này, mục Libraries 

cho thấy các tập tin thư viện hiện dùng. Ở ô Part, Ta gõ vào tên ký hiệu mà ta muốn lấy (thí dụ : gõ vào 

555) ta sẽ thấy hiện ra các nhóm từ có số 555. Từ đây ta hãy chọn ký hiệu mà ta muốn chọn (chức năng 

preview). Nếu đồng ý ta nhấn phím Ok. Ký hiệu ta ấy sẽ gắn dính vào con trỏ, ta hãy tìm nơi thích hợp 

trên trang vẽ để đặt ký hiệu. Để đặt ký hiệu lên trang vẽ, nhấn chuột trái. Ta có thể nhấp tiếp chuột trái để 

đặc thêm ký hiệu này ở các vị trí trên trang vẽ. (Trong khung chọn IC 555B, ký hiệu này hiện ra trong 

khung Preview) 

Nếu ta lấy đúng linh kiện, ta nhấn phím OK để xác nhận. 

Sau khi đặt xong ký hiệu lên trang vẽ, ta sẽ thấy trên vùng làm việc có hình như sau. 

 

 

 

 

 

 

 

 

Để 

lấy các 

điện trở, Bạn gọi ra bảng tên “R” (trong thư viện Analog.Olb) 

Để lấy các tụ điện, Bạn gọi ra bảng tên “C” (trong thư viện Analog.Olb) 
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Để lấy nguồn nuôi, Bạn gọi ra bảng tên “VDC” (trong thư viện Source.Olb) 

Sau khi tất cả các ký hiệu của linh kiện đã đặc xong trên trang vẽ. Ta hãy dùng đến lệnh Place Wire 

để cho nối các đường mạch đi qua các chân của linh kiện. 

Tiêu hình dùng lệnh nối mạch (Place Wire). Ta cũng có thể chọn nhanh lệnh này bằng cách gõ phím 

ký tự “W” (Wire) 

Ở lệnh nối mạch, dấu con trỏ sẽ có dạng hình chữ thập (+). Ta cho con trỏ chạm vào các chân của ký 

hiệu, nhấn chuột và kéo, dây nối sẽ kéo theo qua các chân khác, khi dây nối chạm vào chân linh kiện sẽ 

xuất hiện một chấm tròn đỏ. Ta nhấn phím chuột trái để kết thúc một đường nối, nhấn phím Esc để thôi 

lệnh nối mạch. 

Ta hãy chọn ký hiệu nối Mass, bằng cách gõ phím ký tự “G” (Ground). 

Tiêu hình dùng lấy ký hiệu Mass cho nối vào sơ đồ mạch điện. Sao khi đã nối xong các đường Mass 

chúng ta thấy trong sơ đồ mạch điện. 

Để lấy R1, R2, R3 chúng ta có thể gõ phím tắt “P” và gõ tên linh kiện là “R” 

Để lấy tụ C1, C2 chúng ta có thể gõ phím tắt “P” (Place part) và gõ tên linh kiện là “C”. 

Để lấy nguồn nuôi V1 chúng ta có thể gõ phím tắt “P” và gõ tên linh kiện “VDC” 

Để lấy IC 555,  chúng ta có thể gõ phím tắt“P” và gõ tên linh kiện là “555”. 

Để lấy dấu nối Mass , chúng ta có thể gõ phím tắt”G” và rồi chọn ký hiệu Mass 

Đến đây hãy hoàn chỉnh mạch điện bằng cách biên soạn trị số cho các linh kiện trên sơ đồ mạch 

điện. Để ghi trị số cho các linh kiện, double click trên một trị số của một linh kiện, Ta sẽ thấy hiện ra giao 

diện Dislay 

Properties như 

hình sau: 

 

 

 

 

 

Trong ô Value: gõ vào trị số của linh kiện. Trong mục Display Phormat, nếu ta chọn mục Value 

Only thì sẽ có trị số hiện ra thôi. Nếu chọn mục Do Not Display thì trị số linh kiện sẽ không hiện ra. Soạn 

xong nhấp OK. 
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Sau khi soạn  xong các trị số của các linh kiện trong mạch, ta sẽ thấy sơ đồ mạch điện hoàn chỉnh 

như hình sau: 

 

 

 

 

 

 

 

 

Ghi chú : Để có thể sấp xếp các trị số nằm ở các vị trí bất kỳ ta nên chọn  Mode tắt dính lưới. Đến 

đây, ta đã hoàn thành xong công việc mô tả một sơ đồ mạch điện trên trang vẽ của trình Capture CIS. 

II. LIÊN THÔNG VỚI TRÌNH PSPICE ĐỂ  MÔ PHỎNG NGUYÊN LÝ HOẠT  ĐỘNG: 

Trên đây là mạch dao động dùng IC 555, với các mạch điện dao động ta phải đặt vào mạch điều 

khiển khởi đầu (lệnh IC: Initial Condition). Hãy gõ phím “P” (gọi lệnh Place Part) để mở cửa sổ Place 

Part và chọn thư viện Pspecial rồi chọn tên linh kiện IC 1, ta sẽ lấy ra được ký hiệu dùng để qui định điều 

kiện khởi đầu theo chỉ định trong IC 1. Ta hãy nhấp Duoble Click chuột trên chữ “IC = 0)” để ghi vào 

mức Volt khởi đầu (thí dụ:cho là 0V). Ta cũng có thể dùng lệnh Place Text (dùng phím tắt là “T”) để ghi 

tên các văn bản chú thích lên sơ đồ mạch điện. 

Đến đây là ta đã chuẩn bị xong một mạch điện để chạy trong phần mềm Pspice. 

1. Cách mở phần mềm Pspice để phân tích mạch điện trên: 

Trên vùng làm việc của Capture CIS, ta thấy có một thanh công cụ sau: 

 

 

Trước hết hãy nhấp chuột ở tiêu hình để mở trang phân tích mạch. 
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Ta sẽ thấy hiện ra cửa sổ New Simulation như hình sau: 

 

 

 

 

 

 

Gõ vào ô 

Name tên của trang phân tích (tên tuỳ chọn ). Ví dụ: gõ vào : ”XTH” (một tên nào khác tuỳ ý). 

Đặt tên xong nhấn phím”Create” để mở cửa sổ chọn kiểu dạng phân tích. Ta sẽ thấy hiện ra giao 

diện có nhiều thẻ chọn như hình sau: 

 

 

 

 

 

 

 

 

 

Trong 

giao diện này ở thẻ Analysis, mục Analysis Type cho thấy có 4 cách phân tích chính là: 

a. Bias Point : Dùng xác định điều kiện phân cực DC của một mạch điện. Tính toán xong, ta sẽ có 

mức áp DC trên các điểm mạch và có dòng chảy qua các nhánh . 

b. DC Sweep: dùng cách quét để phân tích các đặc tính của linh kiện điện tử. Như vẽ các đường 

cong đặc tính của Diode, Transistor, Scr, Triac, Các Cổng Logic… 

c. Time Domain (transient): dùng phân tích các mức áp trên các điểm của mạch điện lấy theo biến 

thời gian (trục x lấy theo các biến thời gian). Nó có công dụng như dùng một máy hiện Sóng nhiều 

tia để xem tín hiệu trên các điểm nối của mạch điện . 
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d. AC Sweep/ Noise: dùng phân tích các mức áp trên các điểm nối của mạch điện theo biến tần số và 

góc pha (trục x lấy theo biến tần số hay biến góc pha). Nó dùng vẽ ra đường cong đáp ứng biên tần, 

pha tần của mạch. 

Trong thí dụ trên, ta thử chọn cách phân tích là Transient (trục x lấy theo biến thời gian). Ở dạng phân 

tích này ta chỉ cần gõ số vào các ô trống: 

Trong ô: Run to time, gõ vào khoảng thời gian phân tích (thí dụ: gõ vào 2ms để thử) 

Trong ô: Start Saving Data After, xác định thời điểm bắt đầu cho hiện tín hiệu 

Trong ô : Maximum Step Size, chọn định bước in (thí dụ: gõ vào 0.01ms) 

Ghi chú: nếu ta chọn bước in càng nhỏ, tín hiệu in ra sẽ càng nét, hình càng đẹp nhưng tập tin dữ liệu 

sẽ càng lớn và thời gian phân tích sẽ dài hơn. 

Sau khi đã chọn xong nhấn phím “OK” để trở lại trang vẽ. Ở đây ta chọn tiêu hình cho chạy trình 

Pspice để phân tích mạch. Nhấp chuột trên tiêu hình này để chạy Pspice cho phân 

tích mạch. 

 

 

 

 

 

 

 

 

 

Sau khi 

phân tích 

xong ta sẽ thấy kết quả hiện ra trong trang đồ thị. Trong trang đồ thị này, chúng ta thấy tín hiệu dạng xung 

vuông lấy ra trên chân số 3 của IC 555. Lúc này nếu muốn xem tín hiệu trên điểm nào ta chỉ cần đặt ống 

dò ngay trên điểm đó. Thí dụ đặt ống dò ngay trên chân 2 và 6. Chúng ta sẽ thấy dạng tín hiệu trên chân 2 

và 6 là dạng tín hiệu  răng cưa. 
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Ta có 

thể thay đổi trị số của các linh kiện trên mạch điện rồi cho phân tích lại, ta sẽ có kết quả khác. Ở đây ta 

thay đổi trị số của tụ C1, lấy trị số của tụ nhỏ hơn là 0.0047F. 

Sau khi phân tích  lại ta sẽ thấy kết quả hiện ra như sau: (tần số của tín hiệu đã tăng lên). 

 

 

 

 

 

 

 

 

 

 

 

2. Tóm lại, 

trong Orcad 9.2 ta có thể mô tả mạch điện với rất nhiều loại linh kiện khác nhau, mạch có thể đơn giản 

hay rất phức tạp, mạch có thể gồm các linh kiện loại Analog hay các linh kiện loại Digital. Sau khi 

phân tích xong ta xem kết quả trên các trang đồ thị, qua việc phân tích các kết quả này, sẽ biết được các 

đặc tính của mạch điện và sự vận hành của mạch có đúng với thiết kế hay không. 
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